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Introduction 

MotPlus is a graphical editing tool enabling users to model different fields of knowledge and to build four 
different types of graphical models : Standard, Flowchart, Educational and Ontology. 

Standard

MotPlus Standard are object-oriented modeling tools intended to express various fields of knowledge as 
graphic knowledge models. These models attempt to give a dynamic view on a particular field that is often vast 
and complex, and on the existing links between knowledge objects. 

Flowchart

MotPLus Flowchart is the perfect tool for creating all kinds of business diagrams, from flowcharts and org 
charts to floor plans and technical diagrams. 

Educational IMS Learning Design

The Educational IMS Learning Design specification supports the use of a wide range of pedagogies in online 
learning. Rather than attempting to capture the specifics of many pedagogies, it does this by providing a generic 
and flexible language. This language is designed to enable many different pedagogies to be expressed. The 
approach has the advantage over alternatives in that only one set of learning design and runtime tools then need 
to be implemented in order to support the desired wide range of pedagogies. 

Ontology OWL 

The OWL Web Ontology Language is designed for use by applications that need to process the content of 
information instead of just presenting information to humans. OWL facilitates greater machine interpretability 
of Web content than that supported by XML by providing additional vocabulary along with a formal semantics. 
OWL has three increasingly-expressive sublanguages: OWL Lite, OWL DL, and OWL Full. 

Types of knowledge

Findings in the field of cognitive science indicate that there are various types of knowledge and certain links 
joining these as well as certain rules governing their inter-relationships. MotPlus works with these concepts. 
The software includes a number of graphical icons (Standard) representing the different types of knowledge 
(Concrete: Facts ; Abstract: Concepts , Procedures, Principles and Option ) and the different types of links 
( Composition , Regulation , Specialisation , Precedence , Input or Product , and Instance ). Furthermore, it 
integrates a set of Grammar Rules governing the valid types of links that may join the types of knowledge. 

Finally, MotPlus enables the user to build a multilevel visualisation of a knowledge domain, i.e. Lower Models 
associated to the Knowledge Units making up the various models in a given document. This is MotPlus's 
fundamental characteristic. 

These features enable learning system designers and content experts to build different types of graphical 
models representing any given knowledge domain. The MotPlus Editor is particularly useful when engineering 
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learning systems require that a clear distinction be made between the types of models and the types of 
knowledge in order to choose the appropriate instructional and media processing options. For all these reasons, 
this software is very well suited to such fields as process reengineering or instructional strategy design. 

MotPlus was developed by the LICEF Research centre in the course of creating the MISA Method for 
engineering learning systems. Therefore, the various concepts we have just discussed (types of models, 
knowledge and links, etc.) are described in the MISA document titled Knowledge Modelling Technique . We 
recommend that the user take the time to read this document before using MotPlus. 

The MotPlus User's Guide is designed to get you started building models almost immediately. It begins with an 
example that will help to introduce you to the concept of models. Then a chapter on preliminary information is 
followed by three progressive chapters: Basic Functions, Enhancement Functions, Advanced Functions. The 
description of the basic functions enables you to produce your first models quickly while, in the other chapters, 
you will learn how to refine your layout and apply more advanced MotPlus functions. 

What is a model? 

To introduce the concept of models and the various expressions used in this Guide, we will give an example of 
a Knowledge Model . 

There are many types of models . You may already be familiar with some of them such as taxonomies and 
decision trees. Actually, Knowledge Modelling Technique identifies 13 types of models. The one to use depends 
first on the domain to be modelled . For example, the classification of animal species does not require the same 
type of model as the selection of an income tax rate. The type of model also depends on its purpose . In a given 
domain, the type of model will vary according to the particular aspect to be represented. 

Suppose the ultimate goal is to repair a defective stereo system. To do this, a specialist must perform a 
succession of tasks. Therefore, we would have the following information: 

●     Domain: Electronic. 
●     Purpose of the Modelling: Represent the tasks required for repairing a defective stereo system. 
●     Type of Model: To model these tasks a Procedural Model is needed. 

The Main Standard Model could look something like this: 
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Figure 1  : Example of a Procedural Model 

We will now briefly explain this model (which you may have already intuitively grasped) and describe some of 
the symbols used. The action 'Repair Defective Stereo System' is composed ('C' link) of several Procedures 
numbered 1 through 5 (oval objects) . Two of the Procedures (1 and 5) are composed of conditions or 
Principles (hexagonal objects) preceding ('P' link) each action. Principles followed by Procedures are 
interpreted as 'if…then…'. The three other Procedures (2, 3, and 4) produce ( Input or Product Link : 'IP') in 
turn, two Concept objects (oblong figures) that are each necessary to the performance of a Procedure (Input or 
Product Link: 'I/P'). 

This level-1 model equates to the first step in designing a model. It consists in establishing an overall view of 
the subject to be modelled. This view is not encumbered with details that would make the model difficult to 
understand. However, in many cases, it is important to develop further a domain's Knowledge Model. The way 
to accomplish this is to build other models, i.e. level-2 models, associated to each of the Main Model's 
Knowledge Units that require more explanation. Procedure 2, 'Diagnose Stereo System's Defects', was 
developed into such an explanatory model. 

The symbol in MotPlus, appearing to the upper left of a Knowledge Unit, indicates the existence of an 
associated Lower Model. 

The model associated to the 'Diagnose Stereo System's Defects' Procedure would look as follows: 
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Figure 2  : Lower Model Associated to the 'Diagnose…' Knowledge Unit 

This example demonstrates the benefit of developing into many level-2 Lower Models associated to the 
Knowledge Units since it simplifies significantly the Main Model. 

The Lower Model is built by breaking down the task 'Diagnose Stereo System's Defects' into four Procedures 
(2.1, 2.2, 2.3, and 2.4). Once again, we are faced with a Procedural Model. The fourth Procedure is also broken 
down into four sub-procedures the last of which 'Add to List of Defective Components' produces the Concept 
'List of Defective Components', final result of the sub-model's main task (the 'List of Defective Components' is 
used elsewhere in the Main Model). 

Note that this model contains a new type of knowledge, a Fact (oblong object with inverted corners) . In both 
the illustrated cases, the Fact instantiates ('I' link) the concept to which it is associated. 

For example, the 'Kenwood L-05M Amplifier Diagram' is a specific example of the 'Amplifier Diagram' 
Concept. 

Also note that several Concepts are the Product ('I/P' link) of some Procedures while they are reused as Input 
('I/P' link) by others. 

For example, the 'Sub-diagram to Be Evaluated' Concept is a Product of the 'Select Sub-Diagram' Procedure 
and this Product serves also as Input needed to perform the 'Generate List of Components' Procedure. 
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Furthermore, a new link between two Concepts ('S' link) is illustrated in this model, since one Concept 
specialises the other, more general Concept. 

For example: 'Clarity of Sound' is a sort of 'Attribute'. 

Finally, 'if… then' conditions are found in this model. They take the form of Principles that make up a 
Procedure's prerequisites ('P' link) . 

For example: The 'Value Differs from Standard' Principle is a prerequisite condition to the 'Add to List of 
Defective Components' Procedure. 

As you can see by the symbol, one of this model's Knowledge Units was developed into a level-3 Lower 
Model . It is the 'Process Control Structure' Principle governing ('R' link) the 'Diagnose Stereo System's 
Defects' task. Here again, developing the Principle into an associated Lower Model helps to simplify the level-2 
Upper Model. Therefore, the Modelling of a domain of knowledge often entails nesting several Lower Models 
associated to specific Knowledge Units. 

Let's see how the Lower Model associated to 'Control Process Structure' Knowledge Unit was developed. 

Figure 3  : Lower Model Associated to the 'Process Control…' Knowledge Unit 

This model is fairly simple as it mainly represents a set of conditions governing the order of performance of the 
tasks. It is a Control Structure Model (one of the 13 types described in Knowledge Modelling Technique ). 
The objective here is to illustrate the different conditions governing the order in which the sub-procedures of 
the 'Diagnose Stereo System's Defects' Knowledge Unit must be performed. In this model, each condition is 
expressed as follows: 'if… then…'. 
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In our example, the control structure (level-3 model) affects the performance of procedures related to the 
diagnosis (level-2 model), and the results of the diagnosis affect the performance of the Main Model's (level-1 
model) procedures. The Main Model and Knowledge Units' Lower Models are always nested and dependent on 
one another. MotPlus actually enables you to create such relationships. 

Note that, in this Guide, we often refer to models in a MotPlus document. You must keep in mind that we are 
not talking about several independent models but one Main Model and a series of nested models stemming from 
the Main Model. 

The purpose of the above-mentioned example is to illustrate, at the very outset, a typical model you could 
produce using MotPlus. It answers the question "What is a model?". However, to fully benefit from all this 
software's outstanding features, it is also necessary to learn how to build a model. MISA 's Knowledge 
Modelling Technique is specifically adapted to the needs of learning system designers. It suggests an approach 
for identifying and organising Knowledge Units and their Links in a concept map useful for engineering 
learning systems. However, by applying the basics on types of knowledge, links and models defined by this 
technique, it is possible with MotPlus to build simple or complex Knowledge Models that organise into a 
consistent whole, the Knowledge Units and Links of the various domains to be Modelled. 

Drawn from Knowledge Modelling Technique , here is a summarised list of the steps to modelling a 
knowledge domain: 

●     Select a domain and define the purpose of the Modelling (in our example: the task of repairing a 
defective stereo system). 

●     Select the type of model (in our example: a Procedural Model). 
●     Select the Principal Knowledge Unit based on that purpose (in Figure 1 , it is the 'Repair Defective 

Stereo System' Procedure). 

Integrate other Knowledge Units and Links with the Principal Knowledge Unit based on the type of model 
selected (in Figure 1 , these are the sub-procedures 1 through 5 related to the Principal Knowledge Unit using 
C links). 

●     Complete the Main Model ( Figure 1 ). 
●     Develop the Main Model over several levels ( Figure 2 and Figure 3 ). 
●     Adjust, validate, etc. 

Keep in mind that MotPlus is a tool. It is no substitute for your skill as a model designer, however, it will help 
you to be more efficient when building knowledge models tailored to your needs. 

Learning Systems designe Method develop at the Télé-université's LICEF Research Centre. 
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1. Preliminary Information 

●     1.1 How to Implement MotPlus 
●     1.2 Description of the MotPlus Work Window
●     1.3 Basic Screen Display Features 
●     1.4 Closing a Project 
●     1.5 Saving a Document
●     1.6 Printing a Document 
●     1.7 Viewing a Document Print Preview 
●     1.8 Import MotPlus Document
●     1.9 Defining/Viewing Document Properties and Statistics
●     1.10 MotPlus Help 

1. Preliminary Information

Under Construction 

This chapter discusses MotPlus installation procedure and its principal work window components. 

1.1 How to Implement MotPlus 

The following are the minimum system requirements for running MotPlus: 

●     Pentium 4 processor or better. 
●     Microsoft® Windows® XP. 
●     512MB of RAM. 
●     At least 8 MB of available hard disk space. 
●     Color monitor with 640x480 resolutions. 
●     Mouse (Microsoft® compatible). 

For more information on minimum configuration requirements, consult Windows® documentation. 

1.1.1 Installing MotPlus 

The MotPlus Application is provided on Internet. Here is the installation procedure for the application and 
related files. 

Click on the URL : http://www.licef.teluq.uquebec.ca/eng/index.htm 

Any supplemental trial (more than 30 days) needs a registration number. To request an access, please use « 
Download » above and answer the questionnaire in order to specify your specific needs. 

1.1.2 Opening or Closing the Application 
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Open or close MotPlus just as you would any other Windows® XP application.

1.2 Description of the MotPlus Work Window 

Once it is opened, MotPlus displays a work window where you will create and edit your models. This section 
describes the main features of this window to help you locate more easily each menu, button or graphic object 
when you finally get to work with your new tool. 

 Figure 1  : Work Window 

Title Bar 

The MotPlus window's Title Bar indicates the name of the software, its version number followed by the name 
of the file that is currently opened. The default name any new file is [MotPlus 1]. The Title Bar of each of the 
model windows indicates the name of the file it displays. 

The  icon (on the left) and the , , or buttons (on the right) fulfil the standard functions of any 
other Windows® XP application. 

Menu Bar 

The Menu Bar gives access to a series of drop-down menus containing MotPlus' principal commands. 

Toolbars 

MotPlus has nine types of toolbars: 
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●     Main Toolbar : This toolbar provides quick access to a series of frequently used commands. Many of 
these commands are the same as those you find in most Windows® 2000 or XP applications. 

●     This toolbar can be activated or deactivated by toggling the Main Toolbar command on the View 
Toolbars submenu. 

●     Font Toolbar : This toolbar provides quick access to a series of editing commands relating to the font of 
the text in the graphic objects. 

●     This toolbar can be activated or deactivated by toggling the Font Toolbar command on the View 
Toolbars submenu. 

●     Standard Toolbar : This toolbar provides quick access to a series of commands enabling you to create 
and edit the graphic standard objects. 

●     This toolbar can be activated or deactivated by clicking on the View Toolbars submenu.
●     Flowchart Toolbar : This toolbar provides quick access to a series of commands enabling you to create 

and edit the graphic flowchart objects. 
●     This toolbar can be activated or deactivated by clicking on the View Toolbars submenu. 
●     Educational Toolbar : This toolbar provides quick access to a series of commands enabling you to 

create and edit the graphic Educational objects. 
●     This toolbar can be activated or deactivated by clicking on the View Toolbars submenu.
●     Ontology Toolbar : This toolbar provides quick access to a series of commands enabling you to create 

and edit the graphic Ontology objects. 
●     This toolbar can be activated or deactivated by clicking on the View Toolbars submenu.
●     Labels Toolbar : This toolbar provides quick access to a series of commands enabling you to create and 

edit the Labels. 
●     This toolbar can be activated or deactivated by clicking on the View Toolbars submenu.
●     Variants Toolbar : This toolbar provides quick access to a series of commands enabling you to create 

and edit the Variants. 
●     This toolbar can be activated or deactivated by clicking on the View Toolbars submenu.
●     Layers Toolbar : This toolbar provides quick access to a series of commands enabling you to create and 

edit the Layers. 
●     This toolbar can be activated or deactivated by clicking on the View Toolbars submenu.

Status Bar 

When the mouse points to a button or menu command, a short description of the button's or command's 
function appears on the left side of the Status Bar. 

The last three boxes on the bar indicate-from left to right-whether or not the Caps Lock, Num Lock and Scroll 
Lock keyboard commands are activated. 

This toolbar can also be activated or deactivated by toggling the Status Bar command on the View Toolbars 
submenu. 

Model Window Display Zone 

The Model Window Display Zone is the part of the screen where the model windows of the open MotPlus 
documents are displayed. 

The arrangement and sizing of these windows is managed using the Window menu or the , , , 

LICEF Page 11



buttons located in the upper right corner of each window. 

These buttons follow Window® standards. 

Projects Manager

The Projects Manager displays a list of the currently active projects, including the names of the levels 
Knowledge Model.

1.3 Basic Screen Display Features 

This section explains how to manage screen display of the whole model or parts of it. 

1.3.1 Optimising the Display of the Whole Model 

To display all of a model's objects in the window while optimise its sizing in the available space, click on Full 

Screen Selection  button or Full Screen Model  on the Main Toolbar.

1.3.2 Optimizing the Display of Part of a Model 

To optimize the display in the available space of the objects in a selected zone, double-click on the  button 
on the Main Toolbar.

Adjusting the Model Display 

You can also change the display sizing by using Zoom on the View menu; or the magnification percentage edit 

box  on the Main Toolbar

1.3.3 Creating and Editing a Document 

This section explains how to manage MotPlus documents. 

1.3.3.1 Creating a New Project 

To create a model in a new project, click on the  button on the Main Toolbar or click on New Project on the 
File menu. 

Upon opening, MotPlus' model window displays a blank document titled MotPlus1. You can get right to work 
building your new model. 

1.3.3.2 Opening an Existing Project 
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To open an existing document, click on the  button on the Main Toolbar or click on Open on the File menu. 

This command opens a Windows® Open dialog box where you can locate and open the document using its file 
name. 

1.4 Closing a Project 

To close a project, select a project in the Project Manager. While pressing on the left mouse button and select 
the Close option. 

1.5 Saving a Document 

To store your document in a folder (directory) under an appropriate name, click on one of the save commands 
( Save or Save As ) following Windows® standards. 

1.6 Printing a Document 

MotPlus provides many printing options. If necessary, you can print the active document as a whole (all its 
models), or just the displayed model, or those selected in the list of document models. You can also 
automatically optimise the sizing of each model to fit into a single print page, or spread a model over a grid 
where each box is the equivalent of a print page. 

●     To select the print parameters and start printing, click on the  button on the Main Toolbar or click 
on Print on the File menu. The system opens the Print dialog box. 

Most of the print parameters in this dialog box follow Windows® standards. However, the parameters 
described below are specific to MotPlus. 

Print Range 

●     Complete Subject : All of the models in the active document are printed. 
●     Current Subject : Only the model that is currently displayed is printed. 
●     Models Type : Only the type models selected in the model list are printed.

(Standard, Flowchart, Educational or Ontology) 
●     Current Selection : Only the active model's selected objects are printed 
●     Models ... : Only the models selected in the model list box are printed. 
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To select several models in the model list box, press the SHIFT or CTRL key as per Windows® standards. 

Print in only one page check box   

When this box is checked, a whole model is printed per page. The sizing of each of the project's models is then 
optimised based on the orientation and margins defined for the page. When the Main Model is part of the Print 
Range, it is always printed first. Lower Models are printed in alphabetical order of the parent Knowledge Unit 
names. 

When the box is not checked, the models are printed according to their distribution over the Page Grid. Each 
grid box represents a print page. Therefore, the printing of a model can be spread over several pages. The pages 
are printed from left to right and from top to bottom in relation to the grid. However, when the Main Model is 
part of the Print Range, it is always printed first. Lower Models are printed in alphabetical order of the parent 
Knowledge Unit names.

1.7 Viewing a Document Print Preview 

The Print Preview command on the File menu opens a Windows® viewing window that enables you to 
visualise how your printed document's models will appear using the defined page parameters. The buttons in 
this window's toolbar follow Window® standards.

1.8 Import MotPlus Document

To import a model MotPlus, select the Import in File menu. Only the model's selected objects in the model list 
box are imported. 

1.9 Defining/Viewing Document Properties and Statistics 

It may prove useful for the author or other users to consult a summary description of the model's subject matter. 
They may need to know the last time and date of access, how much time was spent working on it, or how many 
and which Knowledge Units it contains. The following commands will answer all of these questions. 

●     The Document properties command on the File menu opens the Document properties dialog box. 
❍     The tab Summary enables the user to specify the active document's author, keywords, title and 

subject, and enter any relevant Comments. 
❍     The tab Statistics displays various information concerning the document: the number of 

revisions, total editing time, the date and time of creation, last save and last printing, as well as 
the number of each type of object it contains. 

1.10 MotPlus Help 

There are two ways to obtain help information on the most efficient way to use MotPlus. The first is this User's 
Guide and the second is the Online Help Menu. 

To access different ways to search for online help on using MotPlus, just click on MotPLus_Helper of the ' ? ' 
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menu. 
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2. Basic Functions (Standard)

●     2.1 Choose the Type of Model (Standard) 
●     2.2 Creating and Editing Graphic Objects (Standard)
●     2.3 Creating Link (Standard) 
●     2.4 Selecting Graphic Objects (Standard)
●     2.5 Moving Graphic Objects (Standard)

2. Basic Functions (Standard) 

Under Construction 

This chapter explains MotPlus basic functions that you will use to create Standard Knowledge Models. These 
functions will help you to start Modelling with MotPlus as quickly as possible. 

Advice is given on various valid actions to be performed with relation to the graphic objects (create, select, 
move). 

Before reading this chapter, we recommend users to familiarise themselves with the terms described in the 
Section Description of the MotPlus Work Window. 

Upon opening, MotPlus' model window displays a blank document titled MotPlus1 where you can get right to 
work. 

2.1 Choose the Type of Model (Standard) 

We must stress that choosing the type of model is a way to begin Modelling by adopting, at the very outset, a 
specific point of view on the concept being studied. This choice is important, since it determines the type of the 
Principal Knowledge Units and their Links. 

The model's type is selected among the list described in Knowledge Modelling Technique. There are thirteen 
types of models. These are summarised in the following Table : 

Type Sub-type Principal 
Knowledge Unit 

Principal 
Links 

Examples 

  Factual 
System 

Facts I Chronology of historical events 
Multiplication table 

Conceptual 
System 

Taxonomy Concepts S Taxonomy of the animal kingdom 
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  System with 
Components 

Concepts C Automobile with its sub-systems 
and components 

  Hybrid 
Conceptual 

System 

Concepts + Definitions + 
Procedural Attachments 

S, C, R, I/P Geometry, physics and economics 
definitions 

  Serial 
Procedure 

Procedures P Agenda of a meeting 

Procedural 
System 

Parallel 
Procedures 

Procedures P, C Sports tournament with ranking by 
total of points 

  Iterative 
Procedure 

Procedures, Action 
Principles, Input and 
Product Concepts 

P, I/P, C Thermostat feedback loop 

  Laws and 
Theories 

Relational Principles R, C, P Relationship between symptoms 
and sickness 

Prescriptive 
System 

Decision Tree Action Principles P, C Selection of a financial vehicle 

  Control 
Structure 

Action Principles R, C, P Project management principles 

  Process Algorithm Procedure, 
Concepts, and Action 
Principles 

C, I/P, R Diagnosis of a mechanical problem 

Process/
Method 

Method and 
Technique 

Heuristic Procedure, 
Concepts, and Action 
Principles 

C, I/P, R Architectural design of a building 
Project planning 

  Multi-agent 
Process 

Procedure, Concepts and 
Principles (agents) 

C, I/P, R Writing a text as a team 
Budget planning in an organisation 

 

2.2 Creating and Editing Graphic Objects (Standard)

As described in the Introduction, MotPlus helps users to create graphic objects representing the five types of 
knowledge ( Concepts, Procedures, Principles, Option and Facts ) defined in Knowledge Modelling 
Technique. MotPlus even allows you to insert Undefined Knowledge Units that do not fit into any of the 
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regular categories. According to Knowledge Modelling Technique, this type can be associated to an object, such 
as a Skill, Learning Unit or Instrument, that links the current model to another knowledge domain through its 
associated Lower Model. 

In MotPlus, the various types of knowledge can be joined using six types of links ( Composition, Regulation, 
Specialisation, Precedence, Input or Product and Instance ) according to the principles described in 
Knowledge Modelling Technique. There can be single (C) or multiple (C*) Composition Links between two 
Knowledge Units. When there are multiple links, Knowledge Unit A is composed of many examples of 
Knowledge Unit B rather than just one. The Multiple Composition Link is identified by the 'C*' tag. 

MotPlus has an extra Undefined Link (Yes or No) to which you can give whatever name suits your purpose. 
For example, this Link can join a Skill to its related Knowledge Units. 

In MotPlus, all these elements are considered graphic objects and any Modelling process must necessarily begin 
with learning the basic valid actions that may be performed on or with these graphic objects. We will now 
describe in detail the valid actions that may be performed in MotPlus.

2.2.1 Creating Graphic Objects (Standard)

Building a Knowledge Model essentially consists in creating, naming and linking various types of knowledge 
units in order to represent the user's perception of a specific domain of knowledge. One of the main actions is 
therefore to create the graphic objects (Knowledge Units and Links) required to illustrate the user's perception. 
If necessary, you can add Comments to your models. To create a graphic object, you proceed as follows: 

●     On the Editing Toolbar, click on the button showing the desired type of object among the following: 

Concept ; Procedure ; Principle ; Option ; Fact ; Undefined ; Link ; 

Comment . 
●     To create Concept, Procedure, Principle, Option, Fact, or Undefined objects, position the cursor in the 

model window wherever you wish to create the object. While pressing on the left mouse button, move 
the cursor until the object is the desired size. Release the mouse button. The object is in text editing 
mode. If applicable, enter the name of the new object. By right clicking on the Fact button in the toolbar, 
you will open a menu listing the various types of facts you can create. Click on the desired type of fact. 

A check mark appears on the menu beside the type of fact that will be created. 

●     Example : to create a Factual Knowledge Unit related to a Concept. 

The lower right corner of Examples carries a  tag. 

●     Trace : to create a Factual Knowledge Unit related to a Procedure. 
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The lower right corner of Traces carries a  tag. 

●     Statement : to create a Factual Knowledge Unit related to a Principle. 

The lower right corner of Traces carries a  tag. 

●     To create a Comment related to the model, Knowledge Unit or Knowledge Unit Link. 

If, at the outset, the mouse cursor is pointing to the model background, the Comment will relate 
to the model as a whole. While holding down the left mouse button, move the mouse to form a 
box big enough to hold your Comment. Release the mouse button. You can then enter your 
Comment text. When the Comment is selected, an arrow's head faces the centre right handle 
(when pointing to the arrow handle with the mouse, the cursor changes into crossed double 
arrows). If necessary, you can associate this Comment to a Knowledge Unit or Link by dragging 
the arrow's head to the related Knowledge Unit or Link. 

If, at the outset, the mouse is pointing to a Knowledge Unit or Link, the new Comment will be 
directly related to that Knowledge Unit or Link. While holding down the left mouse button, move 
the mouse and release the button wherever you wish to insert your Comment. A box appears 
related to the Knowledge Unit or Link where you may enter your Comment text. If necessary, the 
Comment can be linked to another Knowledge Unit, Knowledge Unit Link or the Knowledge 
Model itself by dragging the arrow's link. 

 

2.3 Creating Link (Standard) 

From Links : to create a Factual Knowledge Unit unrelated to any Knowledge Unit. Its nature will be defined 
by the type of Knowledge Unit to which it is eventually linked. 

The lower right corner of such a type of fact has no tag. 

●     To create another object of the same type, repeat the preceding step. The same button remains 
selected until you click on another command, so you can keep creating more objects of the same type. 

●     To create a link between two Knowledge Units, click on the  button and select one of the two 
following procedures.
In the model window, click on the source Knowledge Unit and drag and drop the link head on the 
destination Knowledge Unit. 

The system then creates the type of link selected in accordance with the integrated (knowledge relationship) 
Grammar Rules. If valid, the Composition Link is chosen by default. 

●     By right clicking on the  button in the toolbar, you will open a menu listing the various types of links 
you can create. Click on the desired type of link and follow the previously explained procedure. 
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By default, a Single Link is created for Composition Links. If you select a Multiple Composition Link, it will be 
symbolised by 'C*' in the model. 

If the Grammar Rules permit it, the system creates the selected type of link. If not, MotPlus automatically 
applies one of the links that are valid in the context. 

A check mark appears on the menu beside the type of link that will be created. 

2.3.1 Table of Grammar Rules (Standard) 

The following Table summarises the valid Links between the various pairs of Knowledge Units. 

Destination Abstract Knowledge Fact 

From Concept Procedure Principle Option Fact Exemple Trace Statement 

Concept 
C, C*, S, 
NT 

IP, NT NT None C,C*, 
I, NT

C, C*,I, 
NT 

NT NT 

Procedure 
IP, NT C, C*, S, P, 

NT 
C,C*, P, 
NT 

P C,C*, 
I, NT 

NT C, C*, I, 
NT 

NT 

Option None Yes, No, NT None NT None None None None

Principle 
R, NT C, C*, P, R, 

NT 
C, C*, S, 
P, R, NT 

None C,C*, 
I, NT

NT NT C, C*, I, 
NT 

Fact
NT NT NT None C,C*, 

R, NT
IP, NT C,C*, P, 

NT
C,C*, P, NT

Exemple NT NT NT None IP, NT C, C*, NT IP, NT NT

Trace 
NT NT NT None C, C*, 

P, NT 
IP, NT C, C*, P, 

NT 
C, C*, P, 
NT 

Statement
NT NT NT None C, C*, 

P, R, 
NT 

R, NT C, C*, P, 
R, NT 

C, C*, P, 
R, NT 
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Refer to Knowledge Modelling Technique for more information about the Grammar Rules governing the 
linking of different types of knowledge units. 

2.3.2 Grammar Rule Exceptions (Standard) 

The Grammar Rules are defined in Knowledge Modelling Technique. However, MotPlus allows certain 
exceptions. 

●     When you create a Link that does not abide by the Grammar Rules and there are no other alternatives, 
MotPlus enables you to generate an Undefined Link. 

●     Upon creation, Undefined Links go immediately into Text Edit mode. You can then immediately 
identify your Link according to your needs. 

●     A Composition Link is always permitted between an Undefined Knowledge Unit and all other types of 
knowledge units. 

●     A Composition Link is permitted between a Concept and an Undefined Knowledge Unit. 
●     In the current version of MotPlus, the AP links mentioned in the Grammar Rules are represented by 

Undefined Links. 

2.3.3 Suggestions on How to Use Knowledge Units and Links (Standard) 

Here are some suggestions related to specific Modelling situations. 

●     To illustrate an object used to perform a procedure, join the Concept -type Knowledge Unit joined 
to the Procedure using an I/P link. 

●     To illustrate an object produced by a procedure, join the Procedure to the Concept -type Knowledge 
Unit using an I/P link. 

●     To illustrate an actor or a person in charge of a procedure, join the Principle -type Knowledge Unit 
to the Procedure using an R link. 
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If appropriate, using an I link, join the Concept to a Fact -type Knowledge Unit indicating the name of the 
person. 

or 

In this example, the use of a Principle and an R link tells the reader that the actor or the person in charge 
affects or controls the Procedure. 

●     To illustrate a resource person, use a Concept -type Knowledge Unit. 

If appropriate, join the Concept using an I link to a Fact -type Knowledge Unit indicating the name of the 
person. 

or 

In this example, the use of a Concept and an I/P link tells the reader that the actor is a source of information 
useful to the Procedure. 

●     To illustrate the dynamics of a knowledge domain, use Procedures. 

If at all possible, identify your procedures using a verb. 

Or, as in the following example, use a term that defines a process. 
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In this example, the static model only enables the user to illustrate that experience has an impact on personality 
(i.e. it represents a set of knowledge establishing the causal link). It would seem more usual to consider 
experience as knowledge describing the nature of objects such as events, situations, and background. In the 
dynamic model, experience is represented by a Concept. The Procedure features a 'Personality Development' 
process, which can eventually be illustrated by a Lower Model describing the process and the rules governing 
the relative impact of experience. 

●     To illustrate Principle-Concept Relationships: 

According to the Grammar Rules defined in Knowledge Modelling Technique, the only direct Link permitted 
between these two types of knowledge units is a Regulation Link (R link). In the following example, the 
statement 'Experience Affects Personality' is illustrated using a Principle governing the Concept 'Personality'. 

Otherwise, concept-principle relationships are usually illustrated using Procedures or Skills. Here are a few 
examples: 

●     In the following figure, the 'Experience' Concept related to the impact rules is illustrated as input into the 
'Develop Personality' process governed by the Principle. 
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●     In the following figure, the Concepts used to define the impact rules are input to the Procedure 
illustrating the action. 

●     In the following figure, the Concepts used by the impact rules are illustrated as input to the procedural 
component of the corresponding Principle. 

●     In the following figure, the 'Life History' is processed by the 'Analyze' Skill to induce the rules 
governing the impact of experience on personality. 
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●     To Illustrate a Knowledge Unit using its components, use C links from this Knowledge Unit to each 
of its component Knowledge Units. 

●     To Illustrate a Knowledge Unit using its categories, use S links from the category Knowledge Units 
to the described Knowledge Unit. 

●     To illustrate a relational Principle in an 'IF (condition). THEN (effect) ' format, use a Principle -
type Knowledge Unit describing the IF condition joined by a P link to another Principle -type 
Knowledge Unit defining the THEN effect. 

●     To illustrate an action Principle in an 'IF (condition). THEN (action) ' format, use a Principle -type 
Knowledge Unit describing the IF condition joined by a P link to another Principle -type Knowledge 
Unit defining the THEN action. 

●     To illustrate an iterative procedure including one or more action loops, use decision Principles in 
the 'IF (condition). THEN (action) ' format. 
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●     To view the valid Links between two types of knowledge units, create a Link between the two. Point 
to the selected Link and display the right click popup menu. Open the Type submenu (see Changing the 
Type of an Existing Knowledge Unit or Link ): the system lists as active commands all the valid types 
of links between the two Knowledge Units. When needed, select one of the valid types of links. 

You can also consult the following Table before creating a Link and, then, choose the appropriate Link in the 
right click popup menu (see Changing the Type of an Existing Knowledge Unit or Link ). 

 

It is then a question of replacing Undefined with AP. 

2.4 Selecting Graphic Objects (Standard)

Selecting is a basic function of all actions involving graphic objects, including moving, copying, deleting, 
editing, and displaying the Lower Model This section describes how to select one or more graphic objects and 
how to resize the Knowledge Unit and Comment objects. 

Clicking on the button on the Editing Toolbar activates the Select command mode. It is automatically 
activated when you perform any equivalent action, e.g. clicking on an object on the model background. 

●     To select a graphic object, just click on the desired object. 

The selected graphic object (Knowledge Unit or Comment) is bordered by an 8-handled box. 

To be able to drag a handle, the mouse must first be pointing to it. The pointer changes into a double-headed 
arrow according to the valid actions to perform for the selected handle. 

The corner handles enable you to resize the selected object horizontally and/or vertically. Place the mouse 
pointer on one of these handles and hold down the mouse button to resize the object. 
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é 

The side handles enable you to resize the selected object only horizontally or only vertically. Place the mouse 
pointer on one of these handles and hold down the mouse button to resize the object. 

é 

You know a Link is selected when you can see its handles. 

To be able to drag a handle, the mouse must first be pointing to it. The pointer takes the shape of crossed 
double arrows indicating that you can move in any direction. 

Using the handles at either end, you can move a Link from one Knowledge Unit to another. Place the mouse 
pointer on one of the handles and drag and drop it onto the appropriate position. 

 

The centre handle enables you to change the link's curve to suit your needs in terms of graphical layout. 

 

.  To select a group of graphic objects, point to the model window background and, while pressing the left 
mouse button move the mouse drawing a box encompassing all the objects to be selected. Release the mouse 
button. 

If it is not possible to include the desired objects in an box, press and hold the CTRL or SHIFT key and click on 
each graphic object to be included or excluded in the selection. 

All the selected graphic objects are identified by their visible handles. 

In a group selection, there is always by default one dominant selection. In the following example, the three 
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Knowledge Units are selected. The dominant Knowledge Unit, the one that will serve as a template for many 
commands, is identified by its dark handles, while those of the other two Knowledge Units are white. Note that 
in a group selection, it is always possible to change dominant selection by clicking on another object. 

Certain commands (ex. box Attributes commands) will affect all the selected Knowledge Units, others (ex. Go 
to Lower Model or change Type ) will only apply to the dominant Knowledge Unit (in our example: Write 
Document's Sections). 

You can also select all the graphic objects in a model by clicking on Select All on the Edit menu or the right 
click popup menu shown when pointing to the model background. 

2.5 Moving Graphic Objects (Standard)

It is sometimes useful to distribute the various graphic objects in such a way as to illustrate the model more 
clearly. In this section, we will show you how to move one or more Knowledge Units or Comments, change the 
source and destination of a link or modify its curve. 

●     To move one or more Knowledge Units or Comments, select the desired object(s), point to the 
selection and drag and drop it onto the selected location. 

●     To change the source or destination of a link, select the link and drag and drop the appropriate handle 
onto the desired Knowledge Unit. 

To invert a link, go to the Link submenu of the right click popup menu shown when pointing to the Link, and 
click on Invert. 

See also Moved or Copied Link's Name Changes. 

●     To change a Link's curve, select a link and drag the centre handle until the link has the desired curve. 
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3 Edit

●     3.1 Copying/Pasting Graphic Objects
●     3.2 Clearing Graphic Objects
●     3.3 Destroying Graphic Objects 
●     3.4 Searching and Replacing Knowledge Unit and Comment Text 

3 Edit

Under Construction 

This chapter explains MotPlus' basic functions that you will use to be performed with relation to the graphic 
objects (move, copy, paste, delete, remove, find, replace, etc.)

3.1 Copying/Pasting Graphic Objects

The Copy function places objects in the clipboard. You can then paste the clipboard content in a selected model 
in the same or a different document. 

However, when a Knowledge Unit is pasted into several models in the same document, it is sometimes difficult 
to edit its text everywhere without worrying about forgetting any occurrences. To overcome this difficulty, 
MotPlus enables you to use the Paste Reference command (paste with their reference) the Knowledge Units in 
the clipboard. A red dot appears on the left side of the object indicating that this Knowledge Unit is referenced. 
All the cross-referenced copies of a Knowledge Unit are considered by MotPlus as one and the same object. 
Consequently, selecting this option ensures that any type or text changes made in the Referenced Knowledge 
Unit will be reflected in all its cross-referenced copies. 

The procedure for copying/pasting with/without reference is as follows.

3.1.1 Copying/pasting Knowledge Units, Grouped Objects Without Reference 

There are three ways to Copy/Paste graphic objects. 

The first is to successively use the Copy and Paste buttons. 

●     Select the object(s) to copy. 

●     Click on the  button on the Main Toolbar or click on Copy on the Edit menu or the right click popup 
menu shown when pointing to the selected object. 

●     In the model chosen for copying (including the currently displayed model), click on the button on the 
Main Toolbar or on Paste on the Edit menu. 

Warning! If you click on Paste when one or more objects in the destination model are selected, 
these will be deleted and replaced by the content on the clipboard. 
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●     Here is a second method for copying one or more objects into the same model: 

 

●     Select the object(s) to Copy/Paste. 
●     Hold the CTRL key down, point to the selection and drag it onto the model background. 
●     The next procedure also enables you to Copy/Paste one or more objects between two tiled model 

windows displaying different documents. 

 

  

●     Select the object(s) to Copy/Paste. 
●     Using the Open command on the File menu, retrieve the desired document. Click on Cascade or Tile in 

the Window menu to simultaneously display both documents. 
●     Activate the window containing the copy source Knowledge Model. While holding down the CTRL key, 

point to the selection and drag and drop it onto the destination window's model background. 

The Lower Models associated with the copied Knowledge Units are not included in the pasted 
version. 

A pasted Knowledge Unit's OLE Link is also copied, meaning both a Knowledge Unit and an OLE Link are 
added to the destination document. 

3.1.2 Copying/Pasting Knowledge Units with their Reference 

There are three procedures you might use to Copy/Paste Knowledge Units with their reference. 

●     The following procedure enables you to paste one or more Knowledge Units directly into a Lower 
Model along with their reference to one of the Knowledge Units of the displayed model. 

é 

●     Select the Knowledge Units to be pasted with reference or select a group of objects including the desired 
Knowledge Units. 

●     While holding down the CTRL key, point to the selection and drag and drop it onto the destination 
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Knowledge Unit. 

MotPlus displays the Lower Model associated to the destination Knowledge Unit and pastes the initially 
selected Knowledge Units along with their reference. The other objects are simply pasted into the Upper 
Model. 

●     Activate the window containing the copy source Knowledge Model. While holding down the CTRL key, 
point to the selection and drag and drop it onto the destination window's model background. 

3.1.3 Undoing One or More Commands 

When certain commands do not produce the desired results or you change your mind in the course of 
developing your model, the following command enables you to undo one or more recently performed 
operations. 

Click as many times as necessary (maximum of 32 times in the same model) on Undo on the Edit menu or the 

 button on the Main Toolbar. This command is inactive when there are no more or not yet any commands to 
undo. 

Undo does not restore text changed with the Replace function. 

3.1.4 Redoing One or More Cancelled Commands 

If you have undone too many commands or simply decide to restore what was cancelled, just follow this 
procedure. 

Click as many times as necessary (maximum of 32 times in the same model) on Redo on the Edit menu or the 

button on the Main Toolbar. This command cancels the effect of the Undo command. It is inactive when 
there are no more or not yet any commands to restore. 

This command will be limited to the commands which you have just made in the selected model

3.2 Clearing Graphic Objects 

The following procedure enables you to delete locally one or more graphic objects. The Clear command 
deletes the selected graphic objects, whether they are referenced or not, only in the displayed model. 

●     Select the desired object(s). 

●     Click on the (black X) button on the Main Toolbar or click on Clear on the Edit menu or the right 
click popup menu shown when pointing to one of the selected objects. 

You can also delete selected object(s) from the model and place them in the clipboard by using Cut on the Edit 

menu or the right click popup menu shown when pointing to a selected object; or by clicking on the  button 
on the Main Toolbar. The Lower Model associated to the cut Knowledge Units will also be not transferred to 
the clipboard. 
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The Links between two Referenced Knowledge Units will always be deleted in all the document's models. 

If a Knowledge Unit selected for deletion is not referenced but has an associated Lower Model, a MotPlus 
dialog box opens. This dialog box requests confirmation that you really want to delete this Knowledge Unit as 
well as its associated Lower Model. 

 

3.3 Destroying Graphic Objects 

The following procedure enables you to destroy one or more graphic objects locally or throughout the 
document. The Destroy command deletes selected non-referenced Knowledge Units locally—same effect as 
Clear —but it deletes Referenced Knowledge Units throughout the entire document. 

●     Select the desired object(s). 

●     Click on the  (red X) button on the Main Toolbar or click on Destroy on the Edit menu or the right 
click popup menu shown when pointing to one of the selected objects. 

If a Knowledge Unit selected for deletion has an associated Lower Model, a MotPlus dialog box opens. This 
dialog box requests confirmation that you really want to delete this Knowledge Unit as well as its associated 
Lower Model. 

 

3.4 Searching and Replacing Knowledge Unit and Comment Text 

In a complex document comprising multiple model levels, it could prove difficult to locate a character string, 
word or phrase used in one of the Knowledge Units or Comments. In addition, if these text elements are 
repeated in a number of Knowledge Units or Comments, it may be just as hard to find all occurrences without 
exception. However, MotPlus Search command makes this task easy. Should the goal of the search is to 
replace the character string, word or phrase being sought, then MotPlus Replace function is the one to select. 

Both Search and Replace are in the Edit menu. 

●     The Search function enables you to locate the Knowledge Units and Comments that contain the text 
entered in the Search field in the Search dialog box. Based on the direction and other parameters 
defined, each time you click on the Search Next button, the system will go to the next Knowledge Unit 
or Comment containing the text entered. 

If no Knowledge Unit or Comment contains the specified text, no result will show up on the screen. Check the 
accuracy of your request. 

Description of the Search Dialog Box 
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●     Search : Edit box for entering the text sought. 
●     Match whole word only : 

❍     Blank —looks for Knowledge Units or Comments containing the string entered in the Search 
what field (whether it is preceded with and/or followed by other characters or not). 

❍     Checked —looks for Knowledge Units or Comments containing whole words matching the text 
entered in the Find what field. 

●     Match case: 
❍     Blank —looks for a match to the text in the Search what field regardless of any uppercase or 

lowercase letters it may contain. 
❍     Checked —looks for an exact match to the text in the Search what field, taking into account any 

uppercase or lowercase letters it may contain. 
●     Search Next Button: Launches the search for the next Knowledge Unit or Comment containing 

matching text. 
●     Cancel Button: Closes the Find Dialog Box. 

The Replace function enables you to search for Knowledge Units and Comments containing a match to the text 
in the Find what field and replace it with the entry in the Replace with field. 

Undo on the Edit menu or the button on the Main Toolbar does not restore text changed using the Replace 
function. 

Description of the Replace Dialog Box 

●     Search what : Edit box for entering the text sought. 
●     Replace with : Edit box for entering the replacement text. 
●     Match whole word only : Searches for whole words and not parts of a longer word. 
●     Match case : Takes into account or disregards any uppercase letters in the search text. 
●     Search Next button: Launches the search for the next Knowledge Unit or Comment containing 

matching text. 
●     Replace button Replaces in the Knowledge Unit or Comment the text matching the Search what entry 

with the Replace with entry and automatically launches a search for the next occurrence. 
●     Replace All button: Replaces with the Replace with entry the text matching the Search what entry 

contained in all the document's Knowledge Units and Comments. 
●     Cancel button: Closes the Replace Dialog Box 
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4 Knowledge Units 

●     4.1 Editing the Labels of Knowledge Units, Comments or Undefined Links 
●     4.2 Creating a Knowledge Unit's Lower Model, Changing Levels 

 

4 Knowledge Units 

Under Construction 

One of MotPlus unique features is multilevel Modelling, i.e. the definition of Lower Models associated to the 
Knowledge Units making up the various models in a given document. We will explain how to create associated 
Lower Models and navigate from level to level. 

4.1 Editing the Labels of Knowledge Units, Comments or Undefined 
Links 

When you create a Knowledge Unit, Comment or Undefined Link, MotPlus automatically goes into Edit Mode 
so you can identify the objects or enter pertinent text. However, we will now explain how to edit the label of 
existing graphic objects: 

●     Double-click with the left mouse button on the Knowledge Unit, Comment or Undefined Link you wish 
to edit. The label is automatically selected and ready to be deleted or replaced by whatever is entered on 
the keyboard. You can change part of the text, cut, copy, and paste some text using the commands on the 
right click popup menu or the Edit Toolbar or the Edit menu. These commands follow Windows® 
standards. 

 

4.2 Creating a Knowledge Unit's Lower Model, Changing Levels 

Sometimes the complexity of a particular domain of knowledge demands the inclusion of a great many 
Knowledge Units and Links in its model. In these cases, you may wish to clarify the representation of the 
domain by retaining only a main model's Knowledge Units while developing these further in Lower Models. 
This is one of MotPlus' fundamental features. Starting from the Main Model (level 1), you can build and 
display a Lower Model (level 2), if need be, for each of the Principal Knowledge Units in the Main Model. 
When the Knowledge Units of the Lower Model require detailing, you can build and display their own 
associated Lower Models (level 3), and so on. The models are nested like Russian dolls. This feature enables 
you to build a multilevel representation of the domain of knowledge. 

See the example shown in Introduction. 

We recommend you follow the procedure explained in Knowledge Modelling Technique when modelling a 
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domain of knowledge. The approach described therein suggests you start by designing an initial model then 
gradually add levels as you develop the model further. 

In the model, Knowledge Units with associated Lower Models are identified by the icon appearing in the 
upper left corner of the object. 

In the drop down menu, Knowledge Units with associated Lower Models are identified by the  icon 
appearing to the left of their name. 

MotPlus enables you to create as many levels as necessary and navigate from one document level to the other. 
To do this, you proceed as follows: 

4.2.1 Creating/Viewing a Knowledge Unit's Associated Lower Model 

For a Knowledge Unit without any associated Lower Model, the following procedure displays an empty model 
where you can build one. If the Knowledge Unit has an associated Lower Model, it will display it, thus enabling 
you to view or edit it according to your needs. 

●     In the displayed model, select the Knowledge Unit for which you wish to develop or view a Lower 

Model and either press ENTER or click on the  button on the Main Toolbar; or click on the Go 

Down  button on the Model Window Toolbar; or click on the Step Forward  button on the 
Model Window Toolbar.

4.2.2 Returning to the Upper Model (Parent Model) 

The procedure for returning to the parent of a displayed Knowledge Unit's Lower Model is as follows. 

Click on the Go Up  button on the Model Window Toolbar; or click on the Step Back  button on 
the Model Window Toolbar

This command is inactive when the Main Model is displayed. 

4.2.4 Returning to the Main Model 

There are two ways to return to the Main Model. 

●     You can go directly to the Main Model by clicking 'Main Model' on the drop-down menu on the Model 
Window Toolbar. 
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●     Since there can be many levels of models, you could also navigate from level to level by clicking as 
many times as necessary on the name of the upper model in the Project Manager.
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5. Graphic Attribute-Related Features 

●     5.1 Defining the Graphic Attributes of Objects to Be Created 
●     5.2 Changing the Graphic Attributes of Existing Objects
●     5.3 Standardising Alignment, Spacing and Sizing of Graphic Objects
●     5.4 Changing the Object Overlay Order 

5. Graphic Attribute-Related Features 

Under Construction 

This section describes some of MotPlus features related to defining the model's graphic attributes. You may 
wish to redesign your graphic objects in general or in particular, modifying their style, color or the thickness of 
their lines. You may seek to emphasize a specific element or just to make your model more attractive. 

For the sake of clarity, it may be necessary to space objects that overlap, align Knowledge Units on the same 
level or select similar sizing for similar objects. MotPlus gives you ways to go about this.

5.1 Defining the Graphic Attributes of Objects to Be Created 

●     Point to the model's background. 
●     Click on Attributes on the Layout menu or Graphic Attributes in the right click popup menu. 

The system opens the Graphic Attributes dialog box where the options in a set of tabs enable you to define the 
background's attributes as well as those of the arcs and boxes used to create graphic objects in the current 
document. 

5.1.1 Description of the Graphic Attributes Dialog Box 
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Figure 1 : Graphic Attributes Dialog Box (Boxes Tab) 

●     In the Graphic Attributes windows you can define the following attributes: 
❍     The Style, Color and Shadow of the border. 
❍     The Pattern as wells as the color of the pattern itself and its background. 
❍     In the tab Background, you can define the color of the model's background and indicate whether 

or not this color should be used for printing. 
❍     You can also change the fill color after you draw the object.
❍     The Font button opens a Windows® Font dialog box for defining text attributes. 
❍     You can indicate whether or not you wish to enhance your Knowledge Unit boxes with a shadow
❍     The style and color of the lines use to draw the Links. 
❍     The shape of the Links at their destination and source. 
❍     Whether or not the Links should be hidden. 

A preview window shows the effect of your selections on the selected Links. 

The background color defined in this dialogue box only applies to the displayed model. 

5.1.2 Positioning the Text in an Object 

The Text submenu on the Layout menu enables you to define the position of the Knowledge Unit or Comment 
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text within the existing or future object's area. 

●     To change the font, click on the appropriate command in the submenu.
●     To left-, right- or center-justify the text, click on the appropriate command in the submenu.
●     To position the text at the top, middle or bottom of the object, click on the appropriate submenu 

commands. 
●     

 

5.2 Changing the Graphic Attributes of Existing Objects 

Select the desired object(s). 

●     Click on Attributes on the Layout menu or Graphic Attributes in the right click popup menu. 

5.2.1 Copy Format Painter

●     By clicking on the  button (Copy Format Painter) on the Editing Toolbar, you can give one or more 
selected objects the same attributes as a previously selected object. The mouse pointer then takes the 
shape of a little paintbrush. 

●     Select the object of which the attributes will be copied. 

●     Click on the  button. 
●     Point to the object to be changed and left click with the mouse or encompass a group of objects in a 

selection square by holding down the mouse button and release it to copy the attributes to all the selected 
objects.

By double clicking on the  button, you can copy attributes to a succession of objects or groups 
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of objects. The Copy Format Painter function remains active until you deactivate it by clicking on 
the background. It is also deactivated as soon as another command is selected. 

The Copy Format Painter command can be used to copy attributes to one or more objects in 
another model of the same or a different MotPlus document.

5.2.2 Copy Object/Link 

To change the type of graphic object : 

●     Select a object (procedure).

●     Click on the button .
●     Select a new object in the current document (Principle). 

By double clicking on the button , you can copy the type of graphic object to a succession of objects or 
groups of objects.

5.3 Standardising Alignment, Spacing and Sizing of Graphic 
Objects 

For the sake of clarity, it may be necessary to space objects that overlap, align Knowledge Units on the same 
level or select similar sizing for similar objects. To do this, you will proceed as follows. 

You must first select more than one object to access the standardising commands described hereunder. 

5.3.1 Aligning Selected Graphic Objects 

●     Alignment on the Layout menu enables you to align selected Knowledge Units, grouped objects and/or 
Comments relative to the dominant selection.

To change the dominant selection, just click on another object in the selected group. 

When you point to this option, a submenu opens containing the following options: 

●     Align to left sides : Aligns the left sides of the selected Knowledge Units, grouped objects and 
Comments with the dominant selection's left side. 

●     Align X centers: Aligns the centers of the selected Knowledge Units, grouped objects and Comments 
with the dominant selection's center. 

●     Align to right sides: Aligns the right sides of the selected Knowledge Units, grouped objects and 
Comments with the dominant selection's right side. Here is an example. 
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●     Align tops: Aligns the tops of the selected Knowledge Units, grouped objects and Comments with the 
dominant selection's top. 

●     Align centers : Aligns the middles of the selected Knowledge Units, grouped objects and Comments 
with the dominant selection's middle. Here is an example. 

 

  

●     Align bottom : Aligns the bottoms of the selected Knowledge Units, grouped objects and Comments 
with the dominant selection's bottom. 

5.3.2 Description of the Arrange Dialog Box 

The Arrangement command enables you to define the spacing and alignment of selected Knowledge Units, 
grouped objects and/or Comments based.

 

Arrange by left sides

The spacing of the left sides of all the selected objects is equal to the spacing of the left sides of the two 
leftmost objects in the selection. Here is an example. 
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Arrange by X center 

The spacing of the centers of all the selected objects is equal to the spacing of the centers of the two left most 
objects in the selection. 

Arrange by right sides 

The spacing of the right sides of all the selected objects is equal to the spacing of the right sides of the two right 
most objects in the selection. 

Arrange horizontal 

The command enables you to define the spacing and alignment of selected Knowledge Units, grouped objects 
and/or Comments based on the horizontal axis and certain reference points. 

Arrange by top sides 

The spacing of the tops of all the selected objects is equal to the spacing of the tops of the two highest objects in 
the selection. 

Arrange by Y centers

The spacing of the middles of all the selected objects is equal to the spacing of the middles of the two middles 
objects in the selection. 

Arrange by bottom sides 

The spacing of the bottoms of all the selected objects is equal to the spacing of the bottoms of the two bottoms 
objects in the selection. Here is an example. 
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Arrange vertically 

The command enables you to define the spacing and alignment of selected Knowledge Units, grouped objects 
and/or Comments based on the vertical axis and certain reference points. 

5.3.3 Equalising the Size of Selected Objects 

The Equalization command on the Layout menu enables you to define the horizontal and/or vertical sizing of 
graphic objects based on the dominant selection's dimensions.

To change the dominant selection, just click on another object in the selected group. 

When you point to this option, a submenu opens containing the following options: 

●     Horizontal : Adjusts the width of the object. 
●     Vertical : Adjusts the height of the object. 
●     Complete : Adjusts both the width and the height of the object. 

The figures here under illustrate the effect of the Complete option.

 

5.4 Changing the Object Overlay Order 

The plane of each new object that is added to a model is layered on top of all the model's existing objects. In a 
complex model, object overlay has an impact on the model's interpretation and clarity. In this section, we will 
explain how you can move graphic object layers forward and back to suit your needs. 

Move to Back on the Position/Layout menu places all the selected graphic objects behind all unselected 
objects. The selected objects will then appear underneath any other overlaid objects. 

Move to Front on the Position/Layout menu places all the selected graphic objects in front of all unselected 
objects. The selected objects will then appear on top of the other objects they overlay. 
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6. OLE Links

●     6.1 Using OLE Links
●     6.2 Viewing the Properties of Graphic Objects 
●     6.3 Creating a Knowledge Unit's Associated Lower Model 

6. OLE Links

Under Construction 

This chapter describes how to use OLE links, and insert MotPlus documents into one another. 

6.1 Using OLE Links 

You may need to insert a document from another application into a MotPlus document. This section explains 
how this is done. 

6.1.1 Attaching an OLE Document to a Model, Knowledge Unit or Comment 

MotPlus provides the way to attach an OLE document. You can select the attachment in a list of applications 
supporting OLE.

To attach from a list of OLE capable applications, click on Insert Object on the Edit menu. 

The action performed depends on the point of insertion defined by the mouse. 

●     When the mouse is pointing to the model background, the system creates a concept and inserts and OLE 
object representing the selected application document. 

●     When the mouse is pointing to a selected Knowledge Unit or Comment, the system inserts an OLE 
object representing the selected application document. 

Both Attach OLE Document and Insert Object open the Windows® Insert Object dialogue box 
where you can choose to create a new OLE object or create one from an existing file. If you 
create a new OLE object, the dialogue box lists the available OLE applications. 

6.1.2 Viewing, Editing and Detaching OLE Documents 

●     To view/edit an OLE document, double click on the OLE document's icon; or select the Knowledge 
Unit or Comment containing the OLE document and click on Open OLE document on the View menu 
or the Knowledge or Comment submenu of the right click popup menu shown when pointing to one or 
the other of these types of objects. 

The View menu command is unavailable when pointing to a grouped object. 
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To open an OLE document within a grouped object, point to the object containing the OLE and 
click on Open OLE document on the Knowledge or Comment submenu of the right click popup 
menu. 

●     To detach an OLE document, select the Knowledge Unit or Comment containing it, click on Detach 
OLE document on the submenu of the right click popup menu shown when pointing to one or the other 
of these types of objects. 

When dealing with a grouped object, detach the OLE document by pointing to the object 
containing it and clicking on the command in the appropriate submenu of the right click popup 
menu. 

6.2 Viewing the Properties of Graphic Objects 

Dialog box displaying the properties of the selected graphic object. This box can remain open, making it 
possible to learn the properties of a series of objects as each one is selected in turn. When no object is selected, 
the model's properties are shown, for example, the model's name. 

●     Click on Properties on the View menu or the right click popup menu.
●     When pointing to the model background or a grouped object background, the command appears directly 

in the right click popup menu. 
●     When pointing to a Knowledge Unit or a Link, the properties display command appears in the 

Knowledge or Link submenu of the right click popup menu, as the case may be. 
●     These commands open a Properties dialog box displaying the following information, depending on the 

object selected: 
❍     Depending on the graphic object selected, the dialog box can have up to three tabs: 

Documentation, Link and References.

❍     The button in the upper right corner closes the dialog box. 
❍     When pointing to the model background, the Object Properties command opens the Model 

Properties dialog box. 

●     The tab Documentation provides four ways to attach a document. 

❍     Paste : To attach an OLE document contained in the clipboard, click on Paste  button. 

❍     OLE : To attach from a list of OLE capable applications, click on the OLE  button. 
❍     Associate model of definition : To attach from a list of subject document, click on the Associate 
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model of definition  button. 
❍     Associate co-model : To attach from a Project Manager list of subject document, click on the 

Associate co-model  button and select the subject. 

 

●     The tab Link  provides the list of all the selected Knowledge Unit's input and output for the current 
model and any other model where it is referenced in the document. The Knowledge Unit's neighbors are 
sorted by type of link. For each type of link, the input or output Knowledge Units are named and sorted 
by type of Knowledge. 

●     The tab References lists all the models where the selected Knowledge Unit is referenced. 

6.3 Creating a Knowledge Unit's Associated Lower Model 

For a Knowledge Unit without any associated Lower Model, the following procedure displays an empty model 
where you can build one. If the Knowledge Unit has an associated Lower Model, it will display it, thus enabling 
you to view or edit it according to your needs. 

●     In the displayed model, select the Knowledge Unit for which you wish to develop or view a Lower 

Model and click on the  button on the Model Windows Toolbar. 
●     The New Folder command enables you to define the New folder.
●     The New subModel of definition command enables you to define the subModel of definition.
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7. Export Tools 

●     7.1 Export to image file
●     7.2 Export to EXCEL file
●     7.3 Export to Access database
●     7.4 Export to HTML
●     7.5 Export to XML
●     7.6 Export to IMS-LD 

 

7. Export Tools 

MotPlus Export tools is the solution that allows you to convert graphic model into formatted Excel 
spreadsheets, HTML pages, Access database, XML file, image file and XML IMS-LD files. 

7.1 Export to image file

The Export to image command in the Tools menu convert the select graphic model into the image file.

Selecting file formats 

●     PCX 
●     JPEG 
●     GIF 
●     TIFF 
●     BMP 

  

7.2 Export to EXCEL file

The Export to Excel command in the Tools menu convert graphic Main Model and Lower Model into the 
Excel spreadsheets.The table below lists the data types supported by the MotPlus software.

●     Name of knowledge 
●     Types of knowledge 

 

7.3 Export to Access database

The Export to Access command in the Tools menu convert graphic model into the Access database. The table 
below lists the data types supported by the MotPlus software.
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●     Comments
●     Types of knowledge
●     Links
●     Labels 
●     Model
●     Projects 
●     References

 

7.4 Export to HTML

The Export to HTML command in the Tools menu convert graphic model into the HTML pages. The table 
below lists the data types supported by the MotPlus software.

●     Comments
●     Types of knowledge
●     Links
●     Labels 
●     Model
●     Projects 
●     References

7.5 Export to XML

The Export to XML command in the Tools menu convert graphic model into the XML pages. The table below 
lists the data types supported by the MotPlus software.

●     Comments
●     Types of knowledge
●     Links
●     Labels 
●     Model
●     Projects 
●     References

 

7.6 Export to IMS-LD 

The Export to IMS-LD command in the Tools menu convert graphic model into the XML IMS-LD pages. The 
table below lists the data types supported by the MotPlus software.

To be able to export a IMS-LD model, you must have installed on your computer Microsoft .NET 
FrameWork version 1.1 and Microsoft Service Pack 1.
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●     Comments
●     Types of knowledge
●     Links
●     Labels 
●     Model
●     Projects 
●     References
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8. Labels 

●     8.1 Creating Labels 
●     8.2 Labelling objects
●     8.3 Deleting Labels

 

8. Labels 

Under Construction 

MotPlus enables you to create or delete a wide variety of labels. The labels can be created in two ways : 
Subject's labels windows or Project's labels windows. The maximum number of labels which one can select is 
32.

 

8.1 Creating Labels 

The Labels command on the View menu enables you to define the label on the Knowledge Unit. 

●     Select Define on the submenu of the Labels Toolbar.
●     While pressing on the left mouse button in the label, move the cursor until the label is in the Subject's 

Labels windows or Project's Labels Windows. 
●     Click on th Ok button.

8.2 Labelling objects

Labels Toolbar provides quick access to a series of commands enabling you to create the Labels. 

●     Select the label on the list of the Subject's labels or Project's labels in the Labels Toolbar.
●     Click on the Knowledge Unit.

8.3 Deleting Labels

The Labels Toolbar provides quick access to a series of commands enabling you to delete the Labels. 

●     Select the label on the list of Subject's labels or Project's labels in the Labels Toolbar.
●     Click on the Knowledge Unit.
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9. Filters

●     9.1 Displaying or Filtering Graphic Objects (by type) 
●     9.2 Marking Links as Hidden

9. Filters

Under Construction 

9.1 Displaying or Filtering Graphic Objects (by type) 

If a model is particularly complicated or if part of a model seems rather secondary or for any other reasons 
related to specific layout needs, it could prove useful to be able to filter out certain types of knowledge units or 
Links or some of the Comments. This section deals with the use of MotPlus' layout filter function. 

●     To display or filter certain types of knowledge units or Links, click on Filters on the View menu. In 
the Filters dialog box, put a check mark next to any types of objects you wish to filter and deselect all 
those you wish to display. 

The following figure illustrates a model before and after this filtering has occurred. 

 

Filter Links by Type 

●     This action affects all the Links that are of the types marked for filtering. 

●     This action affects all the models in the document. 

●     The filtered types are no longer accessible for creating new Links. 

Mark Links as Hidden 

●     This action applies to individual Links. 

●     This action applies to individual models. 

●     This action only affects existing Links. 
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●     This action is independent of the type of link. 
●     Hidden Links may be redisplayed in broken-line format by clicking on a button. 

The Links filtered out using the Filters dialog box cannot be redisplayed in broken-line format by clicking on 
Show Hidden Links on the View menu. This command only displays the non-filtered Links that are marked as 
hidden. 

However, when the Filters dialog box is closed, Links marked as hidden are automatically shown in broken-
line format. This way you can check the behaviour of a filter used on all Links, including those that were 
marked as hidden. 

9.2 Marking Links as Hidden 

To simplify the display of your models, you might wish to hide one or more Links regardless of their type. 
Afterwards, if necessary, Hidden Links may be made to reappear in broken-line format. To do this, you proceed 
as follows: 

 

9.2.1 Hiding Links 

Select the Links to be hidden. 

Select Attributes on the Layout menu or Graphic Attributes on the right click popup menu shown when 
pointing to the selected Links. 

In the Graphic Attributes dialog box, put a check mark besides Mark as hidden. 

 

9.2.2 Displaying Hidden Links 

To display Hidden Links in broken-line format, click on Show Hidden Links on the View menu or the right 
click popup menu shown when pointing to the model background.
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To hide them once again, just toggle one of the above-mentioned commands or button. 

To restore Hidden Links, display them in broken-line format, select the Link to be restored and deactivate the 
Mark as hidden check box in the Graphic Attributes dialog box.
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10. Layers 

●     10.1 Layers MotPlus Subjects 

10. Layers 

Under Construction 

A projects can be made up of many layers and each layer can contain many objects. In MotPlus, the Layers 
window contains a list of layers and six kinds of tools (Create, Select, Delete, Activing object in the layer, 
Editing object, Activing objects in gray and Activing objects in mask). 

Another way to create a unique effect is to use a mask. With masking, you can use a vector object to block out 
part of the underlying model.

The Layers Toolbar displays the current state of all layers in the current model of a document. The name of 
the active layer is highlighted. 

10.1 Layers MotPlus Subjects 

The Layers command on the View menu enables you to define the label on the Knowledge Unit. 

The Layers Toolbar provides quick access to a series of commands enabling you to create and edit the Layers. 

The Layer's window contains six kinds of tools:

●     Creating layer 
❍     Click on the Layers Tollbar. 

❍     Click on the creating button .
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●     Select layer 
❍     Click on the Layers Tollbar.

❍     Click on the select button in the layers list .

 

●     Delete layer 
❍     Click on the Layers Tollbar.

❍     Click on the select button in the layers list 

❍     Click on the delete button .

 

●     Activing object in the layer 1. 
❍     Click on the Layers Tollbar.
❍     Click on the object in the Button layer.

❍     Click on the check box layer 1 .

 

●     Editing object. 
❍     Click on the Layers Tollbar.

❍     Click on the Editing layer button .

 

●     Activing objects in Gray 
❍     Click on the Layers Tollbar.

❍     Click on the Gray button on the list of layers .

 

●     Activing objects in Mask 
❍     Click on the Layers Tollbar.

❍     Click on the Masking button on the list of layers .
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11. Variants

●     11.1 Variants command 

11. Variants

Under Construction 

A projects can be made up of many variants and each variant can contain many objects. In MotPlus, the 
variants windows contains a list of variants and the tree kinds of tools (Create, fusion and delete) 

Another way to create a unique effect is to use a mask. With masking, you can use a vector object to block out 
part of the underlying model.

The Variants Toolbar displays the current state of all variants in the current model of a document. The name 
of the active variant is highlighted and four kinds of tools (Gray Common variant, Changing a variant, 
Changing to the common and Selecting object in the variant). 

 

11.1 Variants command 

The Variants command on the View menu enables you to define the variant on the model Knowledge Unit. 

The Variants Toolbar provides quick access to a series of commands enabling you to create and edit the 
variants. 

The Variant's window contains tree kinds of tools :

 

●     Creating variant 

❍     Click on the Variant button in the Variants Toolbar : 

❍     Click on the creating button in the Variant windows : 

●     Deleting variant 

❍     Click on the Variant button in the Variants Toolbar : 
❍     Select the variant in the variants list.

❍     Click on the Delete button in the Variant windows : .

●     Fusionning variants. 
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❍     Click on the Variant button in the Variants Toolbar : 
❍     Select the name of the variant in the variants list.

❍     Click on the Fusion button : 
❍     Click twice on the name of the variant in the variants list.

The Variant's Toolbar contains five kinds of tools :

●     Creating or selecting variant 

❍     Click on the Variant button in the Variants Toolbar :  

●     Gray Common variant 

❍     Click on the Gray Common variant button in the Variants Toolbar : 

●     Changing a variant 

❍     Click on the Variant button in the Variants Toolbar : 
❍     Select the name of variant.
❍     Select the object.

❍     Click on the Gray Common variant button in the Variants Toolbar : 

❍     Click on the Change a variant button: 

●     Changing to the common 

❍     Click on the Variant button in the Variants Toolbar : 
❍     Select the name of variant.
❍     Select the object.

❍     Click on the Gray Common variant button in the Variants Toolbar : 

❍     Click on the Change to the common button : 

●     Selecting object in the variant 

❍     Click on the Variant button in the Variants Toolbar : 
❍     Select the name of variant.
❍     Select the object.

❍     Click on the Gray Common variant button in the Variants Toolbar : 

❍     Click on the Used or not selected object in the variant buuton : 

 

 

LICEF Page 58



  

LICEF Page 59



12. Model Type 

Under Construction 

 
Model Type 

Standard Flowchart Educational Ontology

Abstract 
Knowledge

Concept, 
procedure, 
option and 
principle

Concept, 
procedure 
and option

Concept :

●     Conference 
Service 

●     Environnement 
●     Index-Search 

Service 
●     Learning Object or 

Outcome 
●     Send-Mail Service 

Procedure 

●     Act 
●     Activity Structure 
●     External Unit of 

learning 
●     Learning Activity 
●     Method 
●     Play 
●     Support Activity 

Principle

●     Time Limit 
●     Learner role 
●     Number of select 
●     Staff role

Concept 

●     Class
●     Datatype 

❍     string 
■     normalizedString 

token
Language
IDREFS 
ENTITIES 
NMTOKEN 
NMTOKENS 
Name 
NCName 
ID 
IDREF 
ENTITY 

❍     decimal 
■     Integer 

nonPositiveInteger 
negativeInteger 
long 
int 
short 
byte 
nonNegativeInteger 
unsignedLong 
unsignedInt 
unsignedShort 
unsignedByte 
positiveInteger

❍     boolean
❍     float
❍     double
❍     duration
❍     dateTime
❍     time
❍     date
❍     gYearMonth
❍     gYear
❍     gMonthDay
❍     gDay
❍     gMonth
❍     hexBinary
❍     base64Binary
❍     anyURI
❍     QName
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❍     Notation

Principe

●     Propriety
●     Cardinality
●     Cardinality min. 
●     Cardinality max. 

Concrete 
Knowledge

Fact None Fact

●     Item 
●     Learning Objective 
●     Metadata Ref 
●     Prerequisites

Fact 

●     Individu

Untyped 
Knowledge

Yes None None None

Comment Yes Yes Yes Yes

Links -Composition 
single (C) -
Composition 
multiple (C*) -
Specialisation 
(S) le lien de -
Precedence (P)
- Input or 
Product ( I/P ) 
-Regulation 
(R) 
-Instanciation 
-Untyped link 

-Composition 
single (C) 
Composition 
Multiple (C*)
Precedence 
(P),
- Input or 
Product (I/P) 
-Untyped link

-Composition (C) 
-Specialisation (S)
- Precedence (P) 
-Intrant-Produit (I/P) -
Regulation (R)
-Application (A).

-Composition (C) 
-Instanciation (I) -Regulation (R)
-Specialisation (S) 
-Equivalent (Equi) 
-Inverse (INV)
-Complement de (Comp)
-Disjoint avec (Disj)
-Identique (Ident) 
-Different de (Diff) 

Copy in the 
Standard 
Lower 
Model 

Copy all 
objects 

Copy only 
the concepts, 
the 
procedures 
and is links. 

Delete all objects Delete all objects 

Main model Yes Yes Yes Yes

Associate 
model of 
Clarification

Yes Yes Yes Yes

Associate 
model of 
definition 

Yes Yes Yes Yes

Associate 
Co-modèle

Yes Yes Yes Yes

Copy in the 
Flowchart 
Lower 
Model 

Copy only the 
concepts, the 
procedures 
and is links. 

Copy all 
objects 

Delete all objects Delete all objects 
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Build a 
Lower 
Model 

Build a 
Standard 
Lower Model 

Build a 
Standard 
Lower Model 

Build a Educationnal 
Lower Model 

Build a Ontology Lower Model 

Copy in the 
Educational 
Lower 
Model 

 

Copy only 
concepts, 
procedures, 
principes, 
Facts and is 
links. 

Copy only 
the concepts, 
the 
procedures 
and is links. 

Copy all objects Delete all objects 

Copy in the 
Ontology 
Lower 
Model 

Copy only 
concepts, 
procedures, 
principes, 
Facts and is 
links. 

Copy only 
the concepts, 
the 
procedures 
and is links.

Delete all objects Copy all objects 
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13. Basic Functions (Standard) 

●     13.1 Choose the Type of Model (Standard) 
●     13.2 Creating and Editing Graphic Objects (Standard)
●     13.3 Creating Link (Standard) 
●     13.4 Selecting Graphic Objects (Standard)
●     13.5 Moving Graphic Objects (Standard)

 

13. Basic Functions (Standard) 

Under Construction 

This chapter explains MotPlus basic functions that you will use to create Standard Knowledge Models. These 
functions will help you to start Modelling with MotPlus as quickly as possible. 

Advice is given on various valid actions to be performed with relation to the graphic objects (create, select, 
move). 

Before reading this chapter, we recommend users to familiarise themselves with the terms described in the 
Section Description of the MotPlus Work Window. 

Upon opening, MotPlus' model window displays a blank document titled MotPlus1 where you can get right to 
work. 

13.1 Choose the Type of Model (Standard) 

We must stress that choosing the type of model is a way to begin Modelling by adopting, at the very outset, a 
specific point of view on the concept being studied. This choice is important, since it determines the type of the 
Principal Knowledge Units and their Links. 

The model's type is selected among the list described in Knowledge Modelling Technique. There are thirteen 
types of models. These are summarised in the following Table : 

Type Sub-type Principal 
Knowledge Unit 

Principal 
Links 

Examples 

  Factual 
System 

Facts I Chronology of historical events 
Multiplication table 
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Conceptual 
System 

Taxonomy Concepts S Taxonomy of the animal kingdom 

  System with 
Components 

Concepts C Automobile with its sub-systems 
and components 

  Hybrid 
Conceptual 

System 

Concepts + Definitions + 
Procedural Attachments 

S, C, R, I/P Geometry, physics and economics 
definitions 

  Serial 
Procedure 

Procedures P Agenda of a meeting 

Procedural 
System 

Parallel 
Procedures 

Procedures P, C Sports tournament with ranking by 
total of points 

  Iterative 
Procedure 

Procedures, Action 
Principles, Input and 
Product Concepts 

P, I/P, C Thermostat feedback loop 

  Laws and 
Theories 

Relational Principles R, C, P Relationship between symptoms 
and sickness 

Prescriptive 
System 

Decision Tree Action Principles P, C Selection of a financial vehicle 

  Control 
Structure 

Action Principles R, C, P Project management principles 

  Process Algorithm Procedure, 
Concepts, and Action 
Principles 

C, I/P, R Diagnosis of a mechanical problem 

Process/
Method 

Method and 
Technique 

Heuristic Procedure, 
Concepts, and Action 
Principles 

C, I/P, R Architectural design of a building 
Project planning 

  Multi-agent 
Process 

Procedure, Concepts and 
Principles (agents) 

C, I/P, R Writing a text as a team 
Budget planning in an organisation 

 

13.2 Creating and Editing Graphic Objects (Standard)
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As described in the Introduction, MotPlus helps users to create graphic objects representing the five types of 
knowledge ( Concepts, Procedures, Principles, Option and Facts ) defined in Knowledge Modelling 
Technique. MotPlus even allows you to insert Undefined Knowledge Units that do not fit into any of the 
regular categories. According to Knowledge Modelling Technique, this type can be associated to an object, such 
as a Skill, Learning Unit or Instrument, that links the current model to another knowledge domain through its 
associated Lower Model. 

In MotPlus, the various types of knowledge can be joined using six types of links ( Composition, Regulation, 
Specialisation, Precedence, Input or Product and Instance ) according to the principles described in 
Knowledge Modelling Technique. There can be single (C) or multiple (C*) Composition Links between two 
Knowledge Units. When there are multiple links, Knowledge Unit A is composed of many examples of 
Knowledge Unit B rather than just one. The Multiple Composition Link is identified by the 'C*' tag. 

MotPlus has an extra Undefined Link (Yes or No) to which you can give whatever name suits your purpose. 
For example, this Link can join a Skill to its related Knowledge Units. 

In MotPlus, all these elements are considered graphic objects and any Modelling process must necessarily begin 
with learning the basic valid actions that may be performed on or with these graphic objects. We will now 
describe in detail the valid actions that may be performed in MotPlus.

13.2.1 Creating Graphic Objects (Standard)

Building a Knowledge Model essentially consists in creating, naming and linking various types of knowledge 
units in order to represent the user's perception of a specific domain of knowledge. One of the main actions is 
therefore to create the graphic objects (Knowledge Units and Links) required to illustrate the user's perception. 
If necessary, you can add Comments to your models. To create a graphic object, you proceed as follows: 

●     On the Editing Toolbar, click on the button showing the desired type of object among the following: 

Concept ; Procedure ; Principle ; Option ; Fact ; Undefined ; Link ; 

Comment . 
●     To create Concept, Procedure, Principle, Option, Fact, or Undefined objects, position the cursor in the 

model window wherever you wish to create the object. While pressing on the left mouse button, move 
the cursor until the object is the desired size. Release the mouse button. The object is in text editing 
mode. If applicable, enter the name of the new object. By right clicking on the Fact button in the toolbar, 
you will open a menu listing the various types of facts you can create. Click on the desired type of fact. 

A check mark appears on the menu beside the type of fact that will be created. 

●     Example : to create a Factual Knowledge Unit related to a Concept. 
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The lower right corner of Examples carries a  tag. 

●     Trace : to create a Factual Knowledge Unit related to a Procedure. 

The lower right corner of Traces carries a  tag. 

●     Statement : to create a Factual Knowledge Unit related to a Principle. 

The lower right corner of Traces carries a  tag. 

●     To create a Comment related to the model, Knowledge Unit or Knowledge Unit Link. 

If, at the outset, the mouse cursor is pointing to the model background, the Comment will relate 
to the model as a whole. While holding down the left mouse button, move the mouse to form a 
box big enough to hold your Comment. Release the mouse button. You can then enter your 
Comment text. When the Comment is selected, an arrow's head faces the centre right handle 
(when pointing to the arrow handle with the mouse, the cursor changes into crossed double 
arrows). If necessary, you can associate this Comment to a Knowledge Unit or Link by dragging 
the arrow's head to the related Knowledge Unit or Link. 

If, at the outset, the mouse is pointing to a Knowledge Unit or Link, the new Comment will be 
directly related to that Knowledge Unit or Link. While holding down the left mouse button, move 
the mouse and release the button wherever you wish to insert your Comment. A box appears 
related to the Knowledge Unit or Link where you may enter your Comment text. If necessary, the 
Comment can be linked to another Knowledge Unit, Knowledge Unit Link or the Knowledge 
Model itself by dragging the arrow's link. 

 

13.3 Creating Link (Standard) 

From Links : to create a Factual Knowledge Unit unrelated to any Knowledge Unit. Its nature will be defined 
by the type of Knowledge Unit to which it is eventually linked. 

The lower right corner of such a type of fact has no tag. 

●     To create another object of the same type, repeat the preceding step. The same button remains 
selected until you click on another command, so you can keep creating more objects of the same type. 

●     To create a link between two Knowledge Units, click on the  button and select one of the two 
following procedures.
In the model window, click on the source Knowledge Unit and drag and drop the link head on the 
destination Knowledge Unit. 

The system then creates the type of link selected in accordance with the integrated (knowledge relationship) 
Grammar Rules. If valid, the Composition Link is chosen by default. 
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●     By right clicking on the  button in the toolbar, you will open a menu listing the various types of links 
you can create. Click on the desired type of link and follow the previously explained procedure. 

By default, a Single Link is created for Composition Links. If you select a Multiple Composition Link, it will be 
symbolised by 'C*' in the model. 

If the Grammar Rules permit it, the system creates the selected type of link. If not, MotPlus automatically 
applies one of the links that are valid in the context. 

A check mark appears on the menu beside the type of link that will be created. 

13.3.1 Table of Grammar Rules (Standard) 

The following Table summarises the valid Links between the various pairs of Knowledge Units. 

Destination Abstract Knowledge Fact 

From Concept Procedure Principle Option Fact Exemple Trace Statement 

Concept 
C, C*, S, 
NT 

IP, NT NT None C,C*, 
I, NT

C, C*,I, 
NT 

NT NT 

Procedure 
IP, NT C, C*, S, P, 

NT 
C,C*, P, 
NT 

P C,C*, 
I, NT 

NT C, C*, I, 
NT 

NT 

Option None Yes, No, NT None NT None None None None

Principle 
R, NT C, C*, P, R, 

NT 
C, C*, S, 
P, R, NT 

None C,C*, 
I, NT

NT NT C, C*, I, 
NT 

Fact
NT NT NT None C,C*, 

R, NT
IP, NT C,C*, P, 

NT
C,C*, P, NT

Exemple NT NT NT None IP, NT C, C*, NT IP, NT NT

Trace 
NT NT NT None C, C*, 

P, NT 
IP, NT C, C*, P, 

NT 
C, C*, P, 
NT 
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Statement
NT NT NT None C, C*, 

P, R, 
NT 

R, NT C, C*, P, 
R, NT 

C, C*, P, 
R, NT 

 

Refer to Knowledge Modelling Technique for more information about the Grammar Rules governing the 
linking of different types of knowledge units. 

13.3.2 Grammar Rule Exceptions (Standard) 

The Grammar Rules are defined in Knowledge Modelling Technique. However, MotPlus allows certain 
exceptions. 

●     When you create a Link that does not abide by the Grammar Rules and there are no other alternatives, 
MotPlus enables you to generate an Undefined Link. 

●     Upon creation, Undefined Links go immediately into Text Edit mode. You can then immediately 
identify your Link according to your needs. 

●     A Composition Link is always permitted between an Undefined Knowledge Unit and all other types of 
knowledge units. 

●     A Composition Link is permitted between a Concept and an Undefined Knowledge Unit. 
●     In the current version of MotPlus, the AP links mentioned in the Grammar Rules are represented by 

Undefined Links. 

13.3.3 Suggestions on How to Use Knowledge Units and Links (Standard) 

Here are some suggestions related to specific Modelling situations. 

●     To illustrate an object used to perform a procedure, join the Concept -type Knowledge Unit joined 
to the Procedure using an I/P link. 

●     To illustrate an object produced by a procedure, join the Procedure to the Concept -type Knowledge 
Unit using an I/P link. 
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●     To illustrate an actor or a person in charge of a procedure, join the Principle -type Knowledge Unit 
to the Procedure using an R link. 

If appropriate, using an I link, join the Concept to a Fact -type Knowledge Unit indicating the name of the 
person. 

or 

In this example, the use of a Principle and an R link tells the reader that the actor or the person in charge 
affects or controls the Procedure. 

●     To illustrate a resource person, use a Concept -type Knowledge Unit. 

If appropriate, join the Concept using an I link to a Fact -type Knowledge Unit indicating the name of the 
person. 

or 

In this example, the use of a Concept and an I/P link tells the reader that the actor is a source of information 
useful to the Procedure. 

●     To illustrate the dynamics of a knowledge domain, use Procedures. 

If at all possible, identify your procedures using a verb. 

Or, as in the following example, use a term that defines a process. 
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In this example, the static model only enables the user to illustrate that experience has an impact on personality 
(i.e. it represents a set of knowledge establishing the causal link). It would seem more usual to consider 
experience as knowledge describing the nature of objects such as events, situations, and background. In the 
dynamic model, experience is represented by a Concept. The Procedure features a 'Personality Development' 
process, which can eventually be illustrated by a Lower Model describing the process and the rules governing 
the relative impact of experience. 

●     To illustrate Principle-Concept Relationships: 

According to the Grammar Rules defined in Knowledge Modelling Technique, the only direct Link permitted 
between these two types of knowledge units is a Regulation Link (R link). In the following example, the 
statement 'Experience Affects Personality' is illustrated using a Principle governing the Concept 'Personality'. 

Otherwise, concept-principle relationships are usually illustrated using Procedures or Skills. Here are a few 
examples: 

●     In the following figure, the 'Experience' Concept related to the impact rules is illustrated as input into the 
'Develop Personality' process governed by the Principle. 
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●     In the following figure, the Concepts used to define the impact rules are input to the Procedure 
illustrating the action. 

●     In the following figure, the Concepts used by the impact rules are illustrated as input to the procedural 
component of the corresponding Principle. 

●     In the following figure, the 'Life History' is processed by the 'Analyze' Skill to induce the rules 
governing the impact of experience on personality. 
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●     To Illustrate a Knowledge Unit using its components, use C links from this Knowledge Unit to each 
of its component Knowledge Units. 

●     To Illustrate a Knowledge Unit using its categories, use S links from the category Knowledge Units 
to the described Knowledge Unit. 

●     To illustrate a relational Principle in an 'IF (condition). THEN (effect) ' format, use a Principle -
type Knowledge Unit describing the IF condition joined by a P link to another Principle -type 
Knowledge Unit defining the THEN effect. 

●     To illustrate an action Principle in an 'IF (condition). THEN (action) ' format, use a Principle -type 
Knowledge Unit describing the IF condition joined by a P link to another Principle -type Knowledge 
Unit defining the THEN action. 

●     To illustrate an iterative procedure including one or more action loops, use decision Principles in 
the 'IF (condition). THEN (action) ' format. 
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●     To view the valid Links between two types of knowledge units, create a Link between the two. Point 
to the selected Link and display the right click popup menu. Open the Type submenu (see Changing the 
Type of an Existing Knowledge Unit or Link ): the system lists as active commands all the valid types 
of links between the two Knowledge Units. When needed, select one of the valid types of links. 

You can also consult the following Table before creating a Link and, then, choose the appropriate Link in the 
right click popup menu (see Changing the Type of an Existing Knowledge Unit or Link ). 

 

It is then a question of replacing Undefined with AP. 

13.4 Selecting Graphic Objects (Standard)

Selecting is a basic function of all actions involving graphic objects, including moving, copying, deleting, 
editing, and displaying the Lower Model This section describes how to select one or more graphic objects and 
how to resize the Knowledge Unit and Comment objects. 

Clicking on the button on the Editing Toolbar activates the Select command mode. It is automatically 
activated when you perform any equivalent action, e.g. clicking on an object on the model background. 

●     To select a graphic object, just click on the desired object. 

The selected graphic object (Knowledge Unit or Comment) is bordered by an 8-handled box. 

To be able to drag a handle, the mouse must first be pointing to it. The pointer changes into a double-headed 
arrow according to the valid actions to perform for the selected handle. 

The corner handles enable you to resize the selected object horizontally and/or vertically. Place the mouse 
pointer on one of these handles and hold down the mouse button to resize the object. 
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é 

The side handles enable you to resize the selected object only horizontally or only vertically. Place the mouse 
pointer on one of these handles and hold down the mouse button to resize the object. 

é 

You know a Link is selected when you can see its handles. 

To be able to drag a handle, the mouse must first be pointing to it. The pointer takes the shape of crossed 
double arrows indicating that you can move in any direction. 

Using the handles at either end, you can move a Link from one Knowledge Unit to another. Place the mouse 
pointer on one of the handles and drag and drop it onto the appropriate position. 

 

The centre handle enables you to change the link's curve to suit your needs in terms of graphical layout. 

 

.  To select a group of graphic objects, point to the model window background and, while pressing the left 
mouse button move the mouse drawing a box encompassing all the objects to be selected. Release the mouse 
button. 

If it is not possible to include the desired objects in an box, press and hold the CTRL or SHIFT key and click on 
each graphic object to be included or excluded in the selection. 

All the selected graphic objects are identified by their visible handles. 

In a group selection, there is always by default one dominant selection. In the following example, the three 
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Knowledge Units are selected. The dominant Knowledge Unit, the one that will serve as a template for many 
commands, is identified by its dark handles, while those of the other two Knowledge Units are white. Note that 
in a group selection, it is always possible to change dominant selection by clicking on another object. 

Certain commands (ex. box Attributes commands) will affect all the selected Knowledge Units, others (ex. Go 
to Lower Model or change Type ) will only apply to the dominant Knowledge Unit (in our example: Write 
Document's Sections). 

You can also select all the graphic objects in a model by clicking on Select All on the Edit menu or the right 
click popup menu shown when pointing to the model background. 

13.5 Moving Graphic Objects (Standard)

It is sometimes useful to distribute the various graphic objects in such a way as to illustrate the model more 
clearly. In this section, we will show you how to move one or more Knowledge Units or Comments, change the 
source and destination of a link or modify its curve. 

●     To move one or more Knowledge Units or Comments, select the desired object(s), point to the 
selection and drag and drop it onto the selected location. 

●     To change the source or destination of a link, select the link and drag and drop the appropriate handle 
onto the desired Knowledge Unit. 

To invert a link, go to the Link submenu of the right click popup menu shown when pointing to the Link, and 
click on Invert. 

See also Moved or Copied Link's Name Changes. 

●     To change a Link's curve, select a link and drag the centre handle until the link has the desired curve. 

 

LICEF Page 75



14. Basic Functions (Flowchart) 

●     14.1 Choose the Type of Model (Flowchart) 
●     14.2 Creating and Editing Graphic Objects (Flowchart) 
●     14.3 Creating Link (Flowchart) 
●     14.4 Selecting Graphic Objects (Flowchart) 
●     14.5 Moving Graphic Objects (Flowchart) 

14. Basic Functions (Flowchart) 

Under Construction 

This chapter explains MotPlus' basic functions that you will use to create Flowchart Knowledge Models. These 
functions will help you to start Modelling with MotPlus as quickly as possible. 

MotPLus Flowchart is the perfect tool for creating all kinds of business diagrams, from flowcharts and org 
charts to floor plans and technical diagrams. 

Advice is given on various valid actions to be performed with relation to the graphic objects (create, select, 
move). 

14.1 Choose the Type of Model (Flowchart) 

We must stress

that choosing the type of model is a way to begin Modelling by adopting, at the very outset, a specific point of 
view on the concept being studied. This choice is important, since it determines the type of the Principal 
Knowledge Units and their Links. 

14.2 Creating and Editing Graphic Objects (Flowchart) 

MotPlus helps users to create Flowchart graphic objects representing the tree types of knowledge ( Concepts, 
Procedures and Option ) defined in Knowledge Modelling Technique. According to Knowledge Modelling 
Technique, this type can be associated to an object, such as a Skill, Learning Unit or Instrument, that links the 
current model to another knowledge domain through its associated Lower Model. 

In MotPlus, the various types of knowledge can be joined using five types of links ( Composition, Precedence 
and Input or Product ) according to the principles described in Knowledge Modelling Technique. There can be 
single (C) or multiple (C*) Composition Links between two Knowledge Units. When there are multiple links, 
Knowledge Unit A is composed of many examples of Knowledge Unit B rather than just one. The Multiple 
Composition Link is identified by the 'C*' tag. 

MotPlus has an extra Untyped Link (Yes or No) to which you can give whatever name suits your purpose. For 
example, this Link can join a Skill to its related Knowledge Units. 
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In MotPlus, all these elements are considered graphic objects and any Modelling process must necessarily begin 
with learning the basic valid actions that may be performed on or with these graphic objects. We will now 
describe in detail the valid actions that may be performed in MotPlus: 

14.2.1 Creating Graphic Objects (Flowchart) 

Building a Knowledge Model essentially consists in creating, naming and linking various types of knowledge 
units in order to represent the user's perception of a specific domain of knowledge. One of the main actions is 
therefore to create the graphic objects (Knowledge Units and Links) required to illustrate the user's perception. 
If necessary, you can add Comments to your models. To create a graphic object, you proceed as follows: 

●     On the Editing Toolbar, click on the button showing the desired type of object among the following: 

Concept ; Procedure ; Option ; Link ; Comment . 
●     To create Concept, Procedure or Option, position the cursor in the model window wherever you wish 

to create the object. While pressing on the left mouse button, move the cursor until the object is the 
desired size. Release the mouse button. The object is in text editing mode. If applicable, enter the name 
of the new object.

●     To create a Comment related to the model, Knowledge Unit or Knowledge Unit Link. If, at the outset, 
the mouse cursor is pointing to the model background, the Comment will relate to the model as a whole. 
While holding down the left mouse button, move the mouse to form a box big enough to hold your 
Comment. Release the mouse button. You can then enter your Comment text. When the Comment is 
selected, an arrow's head faces the centre right handle (when pointing to the arrow handle with the 
mouse, the cursor changes into crossed double arrows). If necessary, you can associate this Comment to 
a Knowledge Unit or Link by dragging the arrow's head to the related Knowledge Unit or Link. 

If, at the outset, the mouse is pointing to a Knowledge Unit or Link, the new Comment will be 
directly related to that Knowledge Unit or Link. While holding down the left mouse button, move 
the mouse and release the button wherever you wish to insert your Comment. A box appears 
related to the Knowledge Unit or Link where you may enter your Comment text. If necessary, the 
Comment can be linked to another Knowledge Unit, Knowledge Unit Link or the Knowledge 
Model itself by dragging the arrow's link. 

14.3 Creating Link (Flowchart) 

From Links : to create a Factual Knowledge Unit unrelated to any Knowledge Unit. Its nature will be defined 
by the type of Knowledge Unit to which it is eventually linked. 

The lower right corner of such a type of fact has no tag. 

See also Changing the Type of an Existing Knowledge Unit or Link. 

●     To create another object of the same type, repeat the preceding step. The same button remains 
selected until you click on another command, so you can keep creating more objects of the same type. 

●     To create a link between two Knowledge Units, click on the  button and select one of the two 
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following procedures.
In the model window, click on the source Knowledge Unit and drag and drop the link head on the 
destination Knowledge Unit. 

The system then creates the type of link selected in accordance with the integrated (knowledge relationship) 
Grammar Rules. If valid, the Composition Link is chosen by default. 

●     By right clicking on the  button in the toolbar, you will open a menu listing the various types of links 
you can create. Click on the desired type of link and follow the previously explained procedure. 

By default, a Single Link is created for Composition Links. If you select a Multiple Composition Link, it will be 
symbolised by 'C*' in the model.

If the Grammar Rules permit it, the system creates the selected type of link. If not, MotPlus automatically 
applies one of the links that are valid in the context. 

A check mark appears on the menu beside the type of link that will be created. 

14.3.1 Suggestions on How to Use Knowledge Units and Links (Flowchart) 

Here are some suggestions related to specific Modelling situations. 

●     To illustrate an object used to perform a procedure, join the Concept -type Knowledge Unit joined 
to the Procedure using an I/P link. 

●     To illustrate an object produced by a procedure, join the Procedure to the Concept -type Knowledge 
Unit using an I/P link. 
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●     To Illustrate a Knowledge Unit using its components, use C links from this Knowledge Unit to each 
of its component Knowledge Units. 

●     To Illustrate a Knowledge Unit using its categories, use S links from the category Knowledge Units 
to the described Knowledge Unit. 

14.3.2 Table of Grammar Rules (Flowchart) 

The following Table summarises the valid Links between the various pairs of Knowledge Units. 

Destination Abstract Knowledge
From Concept Procedure Option
Concept C, C* IP None
Procédure IP C, C* P 
Option None Yes, No, NT NT

 

Refer to Knowledge Modelling Technique for more information about the Grammar Rules governing the 
linking of different types of knowledge units. 

14.3.1 Grammar Rule Exceptions (Flowchart) 

The Grammar Rules are defined in Knowledge Modelling Technique. However, MotPlus allows certain 
exceptions. 

●     When you create a Link that does not abide by the Grammar Rules and there are no other alternatives, 
MotPlus enables you to generate an Untyped Link. 

●     Upon creation, Untyped Links go immediately into Text Edit mode. You can then immediately identify 
your Link according to your needs. 

It is then a question of replacing Untyped with AP. 
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14.4 Selecting Graphic Objects (Flowchart) 

Selecting is a basic function of all actions involving graphic objects, including moving, copying, deleting, 
editing, and displaying the Lower Model. This section describes how to select one or more graphic objects and 
how to resize the Knowledge Unit and Comment objects. 

Clicking on the  button on the Editing Toolbar activates the Select command mode. It is automatically 
activated when you perform any equivalent action, e.g. clicking on an object on the model background. 

●     To select a graphic object, just click on the desired object. 

The selected graphic object (Knowledge Unit or Comment) is bordered by an 8-handled box. 

To be able to drag a handle, the mouse must first be pointing to it. The pointer changes into a double-headed 
arrow according to the valid actions to perform for the selected handle. 

The corner handles enable you to resize the selected object horizontally and/or vertically. Place the mouse 
pointer on one of these handles and hold down the mouse button to resize the object. 

 

The side handles enable you to resize the selected object only horizontally or only vertically. Place the mouse 
pointer on one of these handles and hold down the mouse button to resize the object. 

 

You know a Link is selected when you can see its handles. 

To be able to drag a handle, the mouse must first be pointing to it. The pointer takes the shape of crossed 
double arrows indicating that you can move in any direction. 

Using the handles at either end, you can move a Link from one Knowledge Unit to another. Place the mouse 
pointer on one of the handles and drag and drop it onto the appropriate position. 

é 
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The centre handle enables you to change the link's curve to suit your needs in terms of graphical layout. 

é 

•  To select a group of graphic objects, point to the model window background and, while pressing the left 
mouse button move the mouse drawing a box encompassing all the objects to be selected. Release the mouse 
button. 

You can also select all the graphic objects in a model by clicking on Select All on the Edit menu or the right 
click popup menu shown when pointing to the model background. 

14.5 Moving Graphic Objects (Flowchart) 

It is sometimes useful to distribute the various graphic objects in such a way as to illustrate the model more 
clearly. In this section, we will show you how to move one or more Knowledge Units or Comments, change the 
source and destination of a link or modify its curve. 

●     To move one or more Knowledge Units or Comments, select the desired object(s), point to the 
selection and drag and drop it onto the selected location. 

●     To change the source or destination of a link, select the link and drag and drop the appropriate handle 
onto the desired Knowledge Unit. 

To invert a link, go to the Link submenu of the right click popup menu shown when pointing to the Link, and 
click on Invert. 

See also Moved or Copied Link's Name Changes. 

●     To change a Link's curve, select a link and drag the centre handle until the link has the desired curve. 
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15. Basic Functions (Educational)

●     15.1 Choose the Type of Model (Educational)
●     15.2 Creating and Editing Graphic Objects (Educational)
●     15.3 Types of links
●     15.4 Creating Link (Educational)
●     15.5 Table of Grammar Rules (Educational)
●     15.6 Selecting Graphic Objects (Educational)
●     15.7 Moving Graphic Objects (Educational)
●     15.8 Labels (Educational) 

15. Basic Functions (Educational)

Under Construction 

This chapter explains MotPlus' basic functions that you will use to create Educational IMS Learning Design 
Knowledge Models. 

The IMS Learning Design specification supports the use of a wide range of pedagogies in online learning. 
Rather than attempting to capture the specifics of many pedagogies, it does this by providing a generic and 
flexible language. This language is designed to enable many different pedagogies to be expressed. The 
approach has the advantage over alternatives in that only one set of learning design and runtime tools then need 
to be implemented in order to support the desired wide range of pedagogies. 

Advice is given on various valid actions to be performed with relation to the graphic objects (create, select, 
move, copy, delete, remove, etc.). 

Upon opening, MotPlus' model window displays a blank document standard model titled MotPlus1 where you 
can get right to work. 

15.1 Choose the Type of Model (Educational)

We must stress that choosing the type of model is a way to begin Modelling by adopting, at the very outset, a 
specific point of view on the concept being studied. This choice is important, since it determines the type of the 
Principal Knowledge Units and their Links. 

The Educational command on the Model Type menu enables you to create a Educational IMS Learning 
Design graphic objects.

Note : The objects not-specific to the Educational model will be destroyed.

15.2 Creating and Editing Graphic Objects (Educational)

MotPlus helps users to create Educational graphic objects representing the four types of knowledge 
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( Procedures, Concepts, Principles and Facts ) defined in Knowledge Modelling Technique. 

Procedure

The seven different types of procedure are : Method, Play, Act, Activity Structure, Learning Activity, 
Support Activity and External Unit of learning. 

Concept

The five different types of Concept are : Environment, Conference Service, Index-Search Service, 
Learning Object or Outcome and Send-Mail Service.

Principle

The four different types of Principle are : Learning Role, Staff Role, Number to select and Time limit. 

Fact

The four different types of Fact are : Learning Objectif, Prerequisites, Item and Metadata.
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15.2.1 Creating Graphic Objects (Educational)

Building a Knowledge Model essentially consists in creating, naming and linking various types of knowledge 
units in order to represent the user's perception of a specific domain of knowledge. One of the main actions is 
therefore to create the graphic objects (Knowledge Units and Links) required to illustrate the user's perception. 
If necessary, you can add Comments to your models. To create a graphic object, you proceed as follows: 

●     On the Editing Toolbar, click on the button showing the desired type or sub-type of object among the 

following: Concept ; Procedure ; Principle ; Fact ; Link ; Comment. 
●     To create Concept, Procedure, Principle or Fact position the cursor in the model window wherever 

you wish to create the object. While pressing on the left mouse button, move the cursor until the object 
is the desired size. Release the mouse button. The object is in text editing mode. If applicable, enter the 
name of the new object. By right clicking on the concept, procedure, principle or fact button in the 
toolbar, you will open a menu listing the various types of concept, procedure, principle or fact you can 
create. Click on the desired type of Concept, Procedure, Principle or Fact. 

●     To create a Comment related to the model, Knowledge Unit or Knowledge Unit Link. 

If, at the outset, the mouse cursor is pointing to the model background, the Comment will relate 
to the model as a whole. While holding down the left mouse button, move the mouse to form a 
box big enough to hold your Comment. Release the mouse button. You can then enter your 
Comment text. When the Comment is selected, an arrow's head faces the centre right handle 
(when pointing to the arrow handle with the mouse, the cursor changes into crossed double 
arrows). If necessary, you can associate this Comment to a Knowledge Unit or Link by dragging 
the arrow's head to the related Knowledge Unit or Link. 

If, at the outset, the mouse is pointing to a Knowledge Unit or Link, the new Comment will be 
directly related to that Knowledge Unit or Link. While holding down the left mouse button, move 
the mouse and release the button wherever you wish to insert your Comment. A box appears 
related to the Knowledge Unit or Link where you may enter your Comment text. If necessary, the 
Comment can be linked to another Knowledge Unit, Knowledge Unit Link or the Knowledge 
Model itself by dragging the arrow's link. 

15.3 Types of links

In MotPlus, the various Educational types of knowledge can be joined using six types of links ( Composition, 
Regulation, Precedence, Application, Input or Product and Instance ) according to the principles described 
in Knowledge Modelling Technique. There can be single (C) or multiple (C*) Composition Links between two 
Knowledge Units. When there are multiple links, Knowledge Unit A is composed of many examples of 
Knowledge Unit B rather than just one. The Multiple Composition Link is identified by the 'C*' tag. 

MotPlus has an extra Undefined Link to which you can give whatever name suits your purpose. For example, 
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this Link can join a Skill to its related Knowledge Units. 

In MotPlus, all these elements are considered graphic objects and any Modelling process must necessarily begin 
with learning the basic valid actions that may be performed on or with these graphic objects. 

15.4 Creating Link (Educational)

From Links : to create a Factual Knowledge Unit unrelated to any Knowledge Unit. Its nature will be defined 
by the type of Knowledge Unit to which it is eventually linked. 

The lower right corner of such a type of fact has no tag. 

See also Changing the Type of an Existing Knowledge Unit or Link. 

●     To create another object of the same type, repeat the preceding step. The same button remains 
selected until you click on another command, so you can keep creating more objects of the same type. 

●     To create a link between two Knowledge Units, click on the  button and select one of the two 
following procedures.
In the model window, click on the source Knowledge Unit and drag and drop the link head on the 
destination Knowledge Unit. 

The system then creates the type of link selected in accordance with the integrated (knowledge relationship) 
Grammar Rules. If valid, the Composition Link is chosen by default. 

●     By right clicking on the  button in the toolbar, you will open a menu listing the various types of links 
you can create. Click on the desired type of link and follow the previously explained procedure. 

15.4.1 Suggestions on How to Use Knowledge Units and Links (Educational)

Here are some suggestions related to specific Modelling situations. 

●     The link of instanciation (I) connects a generic element and an authority (Item. Prerequisit ou Learning 
objective).

●     The link of composition (C) connects certain elements to its components (Method, Play, Activity 
structure, role, environment). 

●     The link of precedence (P) connects some under type of procedures to illustrate the sequence between 
them (Act, Activity Structure, Learning Activity, Support Activity). 

●     The Input or Product : Input (Activity Structure, Learning Activity, Support Activity) and Product 
(Activity Structure, Learning Activity, Support Activity).

●     The link of regulation (R) connects a role to an activity (Activity Structure, Learning Activity, Support 
Activity).
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●     The bond of (A) application connects a metadata to a generic element (Activity Structure, Learning 
Activity, Support Activity).

 

15.5 Table of Grammar Rules (Educational)

The following Table summarises the valid Links between the various pairs of Knowledge Units. 

Destination Generic Instance

Origine Concept Procédure Principe Fait

     

Concept                         
●     Environnement 

 C C C C C     IP IP IP  
     

     

●     Learning Object 

or Outcome               

     

 I    

●     Conference 

Service               

     

 I    

●     Send-Mail 
Service               

     
 I    

●     Index-Search 
Service               

     
 I    

Table 1 : Concept

Destination Generic Instance

From Concept Procedure Principle Fact

     

Procedure                         

●     Method         C             I I  

●     Play          C               

●     Act          P C C C            
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●     Activity Structure 
 IP IP IP IP IP     C,P C,P C,P C,P       I    

●     Learning Activity 

 IP IP IP IP IP     P P P P       I I I  

●     Support Activity 

  IP IP IP IP IP     P,A P,A P,A   A     I I I  

●     External Unit of 

learning            P P P P           

Table 2 : Procedure

Destination Generic Instance

From Concept Procedure Principle Fact

     

Principle                         

●     Learning role           R R R R  C     I    

●     Staff role           R R R R  A C    I    

●     Number of select            R              

●     Time Limit        R R R R R R R           

                         

Table 3 : Principle

Destination Generic Instance

From Concept Procedure Principle Fact

     

Fact                         

●     Item                         

●     Learning Objectives 
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●     Prerequisites 
                        

●     Metadata
 A A A A A  A A A A A A        A A A  

Table 4 : Fact

 

15.5.1 Grammar Rule Exceptions (Educational)

The Grammar Rules are defined in Knowledge Modelling Technique. However, MotPlus allows certain 
exceptions. 

●     When you create a Link that does not abide by the Grammar Rules and there are no other alternatives, 
MotPlus enables you to generate an Undefined Link. 

●     Upon creation, Undefined Links go immediately into Text Edit mode. You can then immediately 
identify your Link according to your needs. 

15.6 Selecting Graphic Objects (Educational)

Selecting is a basic function of all actions involving graphic objects, including moving, copying, deleting, 
editing, and displaying the Lower Model This section describes how to select one or more graphic objects and 
how to resize the Knowledge Unit and Comment objects. 

Clicking on the  button on the Editing Toolbar activates the Select command mode. It is automatically 
activated when you perform any equivalent action, e.g. clicking on an object on the model background. 

●     To select a graphic object, just click on the desired object. 
●     To select a group of graphic objects, point to the model window background and, while pressing the 

left mouse button move the mouse drawing a box encompassing all the objects to be selected. Release 
the mouse button.

15.7 Moving Graphic Objects (Educational)

It is sometimes useful to distribute the various graphic objects in such a way as to illustrate the model more 
clearly. In this section, we will show you how to move one or more Knowledge Units or Comments, change the 
source and destination of a link or modify its curve. 

●     To move one or more Knowledge Units or Comments, select the desired object(s), point to the 
selection and drag and drop it onto the selected location. 

●     To change the source or destination of a link, select the link and drag and drop the appropriate handle 
onto the desired Knowledge Unit. 

To invert a link, go to the Link submenu of the right click popup menu shown when pointing to the Link, and 
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click on Invert Link. 

●     To change a Link's curve, select a link and drag the centre handle until the link has the desired curve. 

15.8 Labels (Educational) 

The Educational model enables you to create or delete a wide variety of preselected labels.

 

Figure1 : Labels list 

●     Learning ou Support activity 
❍     manager activity 
❍     observer activity 
❍     participant activity 
❍     moderator activity 

●     Play, Learning Activity, Support Activity, Learning Object, ou Item 
❍     Isvisible true ( default when symbol is created ) = No label 
❍     Isvisible false 

●     Send Mail 
❍     All persons in a role ( default when Send Mail symbol is created ) = No label
❍     Person in a role 

●     Index Search 
❍     Index class (default when Index Search symbol is created) = No label
❍     Index type of element 
❍     1- free text search ( default when Index Search symbol is created ) = No label
❍     2- index with reference 
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❍     3- index without reference 
●     Conference 

❍     1- Synchronous 
❍     2- Asynchronous ( default when Conference symbol is created ) = No label
❍     3- Announcement 

 

See :

http://www.imsglobal.org/learningdesign/index.html 
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16. Basic Functions (Ontology)

●     16.1 Choose the Type of Model (Ontology)
●     16.2 Creating and Editing Graphic Objects (Ontology)
●     16.3 Types of links
●     16.4 Creating Link (Ontology)
●     16.5 Selecting Graphic Objects (Ontology)
●     16.6 Moving Graphic Objects (Ontology)
●     16.7 Labels (Ontology) 

16. Basic Functions (Ontology)

Under Construction 

This chapter explains MotPlus' basic functions that you will use to create Ontology OWL Knowledge Models. 

OWL provides three increasingly expressive sublanguages designed for use by specific communities of 
implementers and users. 

●     OWL Lite supports those users primarily needing a classification hierarchy and simple constraints. For 
example, while it supports cardinality constraints, it only permits cardinality values of 0 or 1. It should 
be simpler to provide tool support for OWL Lite than its more expressive relatives, and OWL Lite 
provides a quick migration path for thesauri and other taxonomies. Owl Lite also has a lower formal 
complexity than OWL DL.. 

●     OWL DL supports those users who want the maximum expressiveness while retaining computational 
completeness (all conclusions are guaranteed to be computable) and decidability (all computations will 
finish in finite time). OWL DL includes all OWL language constructs, but they can be used only under 
certain restrictions (for example, while a class may be a subclass of many classes, a class cannot be an 
instance of another class). OWL DL is so named due to its correspondence with description logics, a 
field of research that has studied the logics that form the formal foundation of OWL. 

●     OWL Full is meant for users who want maximum expressiveness and the syntactic freedom of RDF 
with no computational guarantees. For example, in OWL Full a class can be treated simultaneously as a 
collection of individuals and as an individual in its own right. OWL Full allows an ontology to augment 
the meaning of the pre-defined (RDF or OWL) vocabulary. It is unlikely that any reasoning software 
will be able to support complete reasoning for every feature of OWL Full. 

Each of these sublanguages is an extension of its simpler predecessor, both in what can be legally expressed 
and in what can be validly concluded. The following set of relations hold. Their inverses do not. 

●     Every legal OWL Lite ontology is a legal OWL DL ontology. 
●     Every legal OWL DL ontology is a legal OWL Full ontology. 
●     Every valid OWL Lite conclusion is a valid OWL DL conclusion. 
●     Every valid OWL DL conclusion is a valid OWL Full conclusion. 
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Ontology developers adopting OWL should consider which sublanguage best suits their needs. The choice 
between OWL Lite and OWL DL depends on the extent to which users require the more-expressive constructs 
provided by OWL DL. The choice between OWL DL and OWL Full mainly depends on the extent to which 
users require the meta-modeling facilities of RDF Schema (e.g. defining classes of classes, or attaching 
properties to classes). When using OWL Full as compared to OWL DL, reasoning support is less predictable 
since complete OWL Full implementations do not currently exist. 

OWL Full can be viewed as an extension of RDF, while OWL Lite and OWL DL can be viewed as extensions 
of a restricted view of RDF. Every OWL (Lite, DL, Full) document is an RDF document, and every RDF 
document is an OWL Full document, but only some RDF documents will be a legal OWL Lite or OWL DL 
document. Because of this, some care has to be taken when a user wants to migrate an RDF document to OWL. 
When the expressiveness of OWL DL or OWL Lite is deemed appropriate, some precautions have to be taken 
to ensure that the original RDF document complies with the additional constraints imposed by OWL DL and 
OWL Lite. Among others, every URI that is used as a class name must be explicitly asserted to be of type owl:
Class (and similarly for properties), every individual must be asserted to belong to at least one class (even if 
only owl:Thing), the URI's used for classes, properties and individuals must be mutually disjoint. 

16.1 Choose the Type of Model (Ontology)

We must stress that choosing the type of model is a way to begin Modelling by adopting, at the very outset, a 
specific point of view on the concept being studied. This choice is important, since it determines the type of the 
Principal Knowledge Units and their Links. 

The Ontology command on the Model Type menu enables you to create a Ontology graphic objects.

Note : The objects not-specific to the Ontology model will be destroyed.

16.2 Creating and Editing Graphic Objects (Ontology)

MotPlus helps users to create graphic objects representing the tree types of knowledge ( Concept, Principle, 
Fact ) defined in Knowledge Modelling Technique. According to Knowledge Modelling Technique, this type 
can be associated to an object, such as a Skill, Learning Unit or Instrument, that links the current model to 
another knowledge domain through its associated Lower Model. 

The list of OWL language constructs is given below. 

Concept Exemple

●     Classe

●     Datatype 
(primitive/derived) 
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string 

 

normalizedString 

token

Language 

IDREFS 

ENTITIES (entités) 

 

NMTOKEN 

NMTOKENS

Name 

NCName 

ID 

IDREF 

ENTITY 

boolean
 

float 
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double 
 

decimal 
 

Integer

nonPositiveInteger 

negativeInteger 

long 

int 

short

byte

nonNegativeInteger 

unsignedLong 

unsignedInt 

unsignedShort 

unsignedByte 

positiveInteger 

duration 
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dateTime 

time 

date 

gYearMonth 

gYear 

gMonthDay

gDay 

gMonth 

hexBinary 

base64Binary

anyURI 

QName 

NOTATION

Principle

●     Proprerty

●     Cardinalité

●     Cardinalité min. 
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●     Cardinalité max. 

Fact  

●     Individual

.

16.2.1 Creating Graphic Objects (Ontology)

Building a Knowledge Model essentially consists in creating, naming and linking various types of knowledge 
units in order to represent the user's perception of a specific domain of knowledge. One of the main actions is 
therefore to create the graphic objects (Knowledge Units and Links) required to illustrate the user's perception. 
If necessary, you can add Comments to your models. To create a graphic object, you proceed as follows: 

●     On the Editing Toolbar, click on the button showing the desired type of object among the following: 

Concept ; Principle ; Datatype ; Fact ;Link ; Comment . 
●     To create Concept, Principle, Datatype and Fact objects, position the cursor in the model window 

wherever you wish to create the object. While pressing on the left mouse button, move the cursor until 
the object is the desired size. Release the mouse button. The object is in text editing mode. If applicable, 
enter the name of the new object. By right clicking on the Concept, Principle, Datatype and Fact button 
in the toolbar, you will open a menu listing the various types of concept, principle, datatype or fact you 
can create. Click on the desired type of concept, principle, datatype or fact. 

●     To create a Comment related to the model, Knowledge Unit or Knowledge Unit Link. 

If, at the outset, the mouse cursor is pointing to the model background, the Comment will relate 
to the model as a whole. While holding down the left mouse button, move the mouse to form a 
box big enough to hold your Comment. Release the mouse button. You can then enter your 
Comment text. When the Comment is selected, an arrow's head faces the centre right handle 
(when pointing to the arrow handle with the mouse, the cursor changes into crossed double 
arrows). If necessary, you can associate this Comment to a Knowledge Unit or Link by dragging 
the arrow's head to the related Knowledge Unit or Link. 

If, at the outset, the mouse is pointing to a Knowledge Unit or Link, the new Comment will be 
directly related to that Knowledge Unit or Link. While holding down the left mouse button, move 
the mouse and release the button wherever you wish to insert your Comment. A box appears 
related to the Knowledge Unit or Link where you may enter your Comment text. If necessary, the 
Comment can be linked to another Knowledge Unit, Knowledge Unit Link or the Knowledge 
Model itself by dragging the arrow's link. 

16.3 Types of links

In MotPlus, the various Ontology types of knowledge can be joined using six types of links ( Composition, 

LICEF Page 96



Regulation, Specialisation, Equivalent, Inverse, Complement, Disjoint, Identical and Diffent) according to 
the principles described in Knowledge Modelling Technique. There can be single (C) or multiple (C*) 
Composition Links between two Knowledge Units. When there are multiple links, Knowledge Unit A is 
composed of many examples of Knowledge Unit B rather than just one. The Multiple Composition Link is 
identified by the 'C*' tag. 

MotPlus has an extra Untyped Link to which you can give whatever name suits your purpose. For example, 
this Link can join a Skill to its related Knowledge Units. 

In MotPlus, all these elements are considered graphic objects and any Modelling process must necessarily begin 
with learning the basic valid actions that may be performed on or with these graphic objects. We will now 
describe in detail the valid actions that may be performed in MotPlus: 

16.3.1 Suggestions on How to Use Knowledge Units and Links (Ontology) 

Here are some suggestions related to specific Modelling situations. 

●     If appropriate, join the Concept using an I link to a Fact -type Knowledge Unit indicating the name of 
the person. 

●     To Illustrate a Knowledge Unit using its components, use C links from this Knowledge Unit to each 
of its component Knowledge Units. 

 

●     To Illustrate a Knowledge Unit using its categories, use S links from the category Knowledge Units 
to the described Knowledge Unit. 

●     

According to the Grammar Rules defined in Knowledge Modelling Technique, the only direct Link 
permitted between these two types of knowledge units is a Regulation Link (R link).
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●     Two classes may be stated to be equivalent. Equivalent classes have the same instances. Equality can be 
used to create synonymous classes. 

●     One property may be stated to be the Inverse of another property. 

●     The Complement construct selects all individuals from the domain of discourse that do not belong to a 
certain class. 

●     Classes may be stated to be Disjoint from each other. 

●     This mechanism is similar to that for classes, but declares two individuals to be Identical. 
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●     An individual may be stated to be Different from other individuals.

 

16.4 Creating Link (Ontology)

From Links : to create a Factual Knowledge Unit unrelated to any Knowledge Unit. Its nature will be defined 
by the type of Knowledge Unit to which it is eventually linked. 

The lower right corner of such a type of fact has no tag. 

See also Changing the Type of an Existing Knowledge Unit or Link. 

●     To create another object of the same type, repeat the preceding step. The same button remains 
selected until you click on another command, so you can keep creating more objects of the same type. 

●     To create a link between two Knowledge Units, click on the  button and select one of the two 
following procedures.
In the model window, click on the source Knowledge Unit and drag and drop the link head on the 
destination Knowledge Unit. 

The system then creates the type of link selected in accordance with the integrated (knowledge relationship) 
Grammar Rules. If valid, the Composition Link is chosen by default. 

●     By right clicking on the  button in the toolbar, you will open a menu listing the various types of links 
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you can create. Click on the desired type of link and follow the previously explained procedure. 

16.4.1 Table of Grammar Rules (Ontology)

The following Table summarises the valid Links between the various pairs of Knowledge Units. 

Destination Abstract Knowledge

Origine Concept Datatype Principle Fact

Nom de l'objet Concept Principle Fact
Concept           

●      Class  S
Equi

Comp
Disj

  R       I, C 

●      Datatype   
       I

Principle           

●      Property
 R R  

S 
Equi
Inv

    R

●      Cardinality   
  R

 
    

●      Cardinality min.   
  R

 
    

●     Cardinality max.   
  R

 
    

Fact            

●      Individual   
  R      

Ident
Diff 

 

Refer to Knowledge Modelling Technique for more information about the Grammar Rules governing the 
linking of different types of knowledge units. 

16.4.2 Grammar Rule Exceptions (Ontology)

The Grammar Rules are defined in Knowledge Modelling Technique. However, MotPlus allows certain 
exceptions. 

●     When you create a Link that does not abide by the Grammar Rules and there are no other alternatives, 
MotPlus enables you to generate an Undefined Link. 

●     Upon creation, Undefined Links go immediately into Text Edit mode. You can then immediately 
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identify your Link according to your needs. 

16.5 Selecting Graphic Objects (Ontology)

Selecting is a basic function of all actions involving graphic objects, including moving, copying, deleting, 
editing, and displaying the Lower Model This section describes how to select one or more graphic objects and 
how to resize the Knowledge Unit and Comment objects. 

Clicking on the button on the Editing Toolbar activates the Select command mode. It is automatically 
activated when you perform any equivalent action, e.g. clicking on an object on the model background. 

●     To select a graphic object, just click on the desired object. 

●     To select a group of graphic objects, point to the model window background and, while pressing the 
left mouse button move the mouse drawing a box encompassing all the objects to be selected. Release 
the mouse button. 

16.6 Moving Graphic Objects (Ontology)

It is sometimes useful to distribute the various graphic objects in such a way as to illustrate the model more 
clearly. In this section, we will show you how to move one or more Knowledge Units or Comments, change the 
source and destination of a link or modify its curve. 

●     To move one or more Knowledge Units or Comments, select the desired object(s), point to the 
selection and drag and drop it onto the selected location. 

●     To change the source or destination of a link, select the link and drag and drop the appropriate handle 
onto the desired Knowledge Unit. 

To invert a link, go to the Link submenu of the right click popup menu shown when pointing to the Link, and 
click on Invert. 

See also Moved or Copied Link's Name Changes. 

●     To change a Link's curve, select a link and drag the centre handle until the link has the desired curve. 

16.7 Labels (Ontology) 

The Ontology model enables you to create or delete a wide variety of preselected labels.

Class   

 Class collection “All different individuals“ 

 Class Collection “One of” 
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 Class Collection “Union of” 

 Class Collection “Intersection of” 

Property   

 Symetric 

 Transitive 

 Functional 

 Inverse Functional 

 AllValuesFrom 

 someValuesFrom 

  

See : 

OWL Web Ontology Language Overview ( W3C Recommendation 10 February 2004 )
http://www.w3.org/TR/2004/REC-owl-features-20040210/

OWL Web Ontology Language Guide ( W3C Recommendation 10 February 2004 )
http://www.w3.org/TR/owl-guide/

OWL Web Ontology Language Reference ( W3C Recommendation 10 February 2004 )
http://www.w3.org/TR/2004/REC-owl-ref-20040210/ 

OWL Web Ontology Language - Parsing OWL in RDF/XML (W3C Working Group Note 21 January 2004)
http://www.w3.org/TR/2004/NOTE-owl-parsing-20040121/ 
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17 RECOMMENDATIONS 

17.1 RECOMMENDATIONS ON THE USE OF Untyped 
KNOWLEDGE UNITS AND LINKS

●     Use Untyped Knowledge Units (Standard) mostly to add complementary descriptive elements to the 
Knowledge Model. You can then filter out this type of Knowledge Unit without affecting the essential part 
of the knowledge domain's representation.

●     Use the Untyped type to associate Knowledge Units (Standard) (e.g. Skill, Learning Unit, Instrument) from 
other knowledge domains.
For example, the model into which the Untyped Knowledge Unit is integrated illustrates a particular 
knowledge domain. On the other hand,…
… a Skill's Lower Model describes the domain studying the knowledge. 
…a Learning Unit's Lower Model describes the instructional domain.
… an Instrument's Lower Model describes the learning material production domain. 

●     Use the Untyped type (Standard) to illustrate the transfer of Knowledge Units from a known domain of 
application to another domain.
For example, an Untyped Knowledge Unit's Lower Model illustrating a mathematical formula can serve to 
link a model describing a physical domain phenomenon. 

●     When joining Untyped Knowledge Units (Standard), as a rule, use Untyped Links.
To make models easier to understand and compare, we recommend you abide by the defined Grammar 
Rules and use this type of link only for joining Untyped Knowledge Units to other types of knowledge units.
MotPlus enables you to specify, as needed, the name of this type of link. 

●     Use the Untyped Knowledge Units and Links (Standard) to suit your needs, mainly when using MotPlus for 
other types of Modelling.
For example, you can use them to model learning events or learning scenarios.

●     You could even use an Untyped Knowledge Unit (Standard) to create a round-cornered frame.
●     Knowledge Modelling Technique suggests using Comments to specify learning needs related to a model's 

Principal Knowledge Units.
Learning needs are defined as a scale of competency (conceptual meta-knowledge).

●     Also consider inserting OLE documents in Comment-type objects linked to the Knowledge Units.
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In this way, you will be able to filter out the OLE documents if necessary.

17.2 DIFFERENCE BETWEEN THE ATTACH OLE 
DOCUMENT, INSERTING OBJECT AND COPY 
REFERENCE COMMANDS

●     All three commands serve to insert a file from another application into a MotPlus document. The file is 
linked by an OLE link. However, each of these commands has its own specific functions.
The Attach OLE Document command (see Attaching an OLE Document to a Model, Knowledge Unit or 
Comment) is only active when a Knowledge Unit or Comment is selected.
Mainly use this command when you wish to attach a new or existing OLE document from one of the OLE-
capable applications listed.

●     The Insert Object (see Attaching an OLE Document to a Model, Knowledge Unit or Comment, command 
has a different effect depending on the insertion point defined by the mouse pointer. If the insertion point is 
a Knowledge Unit or Comment, its action is the same as Attach OLE Document.
Mainly use this command when you wish to attach to a MotPlus Model a new or existing OLE document 
from one of the OLE-capable applications listed.

●     The effect of the Paste Reference command (see Attaching an OLE Document to a Model, Knowledge 
Unit or Comment) depends on the source of the clipboard's content and the point of insertion defined by 
the mouse pointer. 

●     Mainly use this command when you want the attached OLE document to contain whatever is in the 
clipboard. The attached document's type of application is, by default, the same at that of the source of the 
clipboard's content.

17.3 DIFFERENCE BETWEEN THE CUT, ClEAR AND 
DESTROY COMMANDS

●     As far as display is concerned, the Cut command is similar to the Delete command (see Clearing Graphic 
Object). The selected graphic objects disappear from the displayed model; the difference is that, in the 
case of Cut, the objects are transferred to the clipboard.
See also How to Avoid Losing Lower Models.

●     With the Destroy command, the selected graphic objects disappear only from the displayed model. The 
copies of these objects (whether they are referenced or not) that were previously pasted in any other 
models of the document are not deleted from their respective models.

●     With the Destroy command (see Destroying Graphic Objects), selected Referenced Knowledge Units are 
deleted from all models in the document where they were pasted. But any unreferenced graphic objects 
that are selected disappear only from the displayed model. This means that their copies previously pasted 
in any other models of the document are not deleted from their respective models.
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17.4 DIFFERENCE BETWEEN THE OPEN LOWER/UPPER 
MODEL COMMANDS

●     In fact, these commands enable easy navigation among the various levels of the document.
The Open Lower Model command opens a new model window of the same document. This new window 
displays the selected Knowledge Unit's Lower Model.

●     The Open Upper Model command opens a new model window of the same document. This new window 
shows the parent of the displayed Lower Model.

●     These commands serve to open another window to enable you to view and edit two models of the same 
document. To display both models simultaneously, click on Cascade or Tile. You can then compare the 
models, transfer Knowledge Units from one to the other or just edit them.
When many model windows are opened at once, MotPlus commands only affect the active window.

17.5 HOW TO AVOID LOSING LOWER MODELS

Two conditions related to Windows® standards may potentially lead to the loss of a model in a MotPlus 
document:

1.  In MotPlus, the function of the Cut command follows the principles defined for Windows® applications. 
Therefore, selected graphic objects are removed from the displayed model and transferred to the 
clipboard.
This command also transfers any Lower Models associated to the cut Knowledge Units. 
ATTENTION: Do not forget that the clipboard is shared by all applications. If you replace the cut 
Knowledge Unit in the clipboard by different content, its associated Lower Models will also be lost. To 
avoid losing Lower Models, we recommend you click on Paste Reference immediately to retrieve the 
content of the clipboard (see Copying/Pasting Knowledge Units with their Reference).

2.  In MotPlus, the function of the Paste command follows the principles defined for Windows® applications. 
Therefore, selected graphic objects are overwritten by the content of the clipboard.
If the selected Knowledge Units have associated Lower Models, these will also be automatically deleted 
from the displayed model.
ATTENTION: As per Windows® standards, you must check for yourself to make sure that you truly wish to 
overwrite not only the selected Knowledge Unit but also its Lower Models in the displayed model.

17.6 TIPS ON HOW TO USE THE GRAPHIC ATTRIBUTES 
FOR EFFECT

MotPlus provides many ways to modify the graphic attributes. For example, you can change the 
following attributes:

●     The Knowledge Units' pattern as well as the colour of the pattern itself and its background.
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●     The style and color of the border used to draw Knowledge Units.
The character font, style, size and color of the text used to identify the Knowledge Units.

●     The style, colour and shape of the lines used to draw the Links.
●     The color of the model background.

You may wish to modify certain attributes for some of the following reasons:
●     Visually enhance or refine you models.
●     Emphasize the Principal Knowledge Unit.
●     Emphasize important Knowledge Units or Links.

For example, you can make it easier to spot Knowledge Units that were pasted in two different places in 
the same model.

●     Emphasize a particular type of Knowledge Unit.
For example, you could use a specific color to differentiate Input Concepts from Product Concepts in a 
process.

●     Categorize sub-types of knowledge units.
For example, by using a different color and/or style of border, you could identify the various categories of 
Concepts in terms of their importance in the model, e.g. primary, secondary, or tertiary.

The following are a few practical applications of using graphic attributes for effect:

17.6.1 Adding a Model Title

To create a framed title, you could use a Concept type of Knowledge Unit.
You can also go to the Graphic Attributes dialogue box to remove the shadow and/or select the 
appropriate background color or border. You can also change the text attributes to make the title stand 
out.

Using an Untyped type of Knowledge Unit (Standard) offers the advantage of enabling you to filter the 
title out of the model without affecting its other Knowledge Units.
For a title without a frame, use any type of Knowledge Unit (preferably Untyped).
However, in this case, you select 'Transparent' for the background and border. You can also change the 
text attributes to distinguish the title from the text in the model's Knowledge Units.

17.6.2 Framing Models

●     To frame your model, you could create a Concept Knowledge Unit.
●     Delete the Knowledge Unit's label.
●     Position the Knowledge Unit and adjust its size as desired.
●     Send it to the back, behind all other graphic objects.
●     In the Graphic Attributes dialogue box, remove the shadow or select the appropriate background color or 

border.

17.6.3 Adding Legends to Models

●     Use any appropriate type of object to create a legend.
●     Label your objects or not.
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●     Position and adjust the size of the objects. Use, if appropriate, the object overlay adjustment commands.
●     Modify the graphic attributes of each object as needed.

If necessary, group objects together.
●     Here is an example of a legend that might be added to a model:
●     The figure on the left illustrates all the objects (broken lines) used to make up the legend. In this example, 

only Untyped objects were used.
●     The figure on the right illustrates the completed legend with grouped objects.

17.7 TROUBLESHOOTING PRINTING PROBLEMS

Your model prints over several pages:
Activate the Print Models on one Page option in the Print dialogue box (see Description of the Print 
Dialog Box).
Your model is overcrowded or the names of the Knowledge Units and Links are hard to read:
Consider one or more of the following solutions.

●     If the page orientation is 'Portrait', change it to 'Landscape'.
●     Reduce the number of Knowledge Units and Links in your model.
●     Transfer the Ancillary Knowledge Units to Lower Models keeping only the Principal Knowledge Units in the 

model to be printed.
●     Use filters to eliminate certain types of knowledge units and Links.
●     Mark as hidden the Links you consider less important.
●     If appropriate, filter out Comments.
●     Reposition the model's Knowledge Units.
●     When the Print Models on one Page option is checked (see Description of the Print Dialog Box), you can 

optimize the print size of the model by moving the Knoweledge Units closer together. To save space, you 
can also shrink each Knowledge Unit as much as possible.

●     If 'Landscape' is selected as the page orientation, click on Fit Model in Window (see Optimising the 
Display of the Whole Model, Page 31) and optimize the distance between Knowledge Units within the 
model window.

●     If the 'Portrait' page orientation was selected: select Page Grid; adjust the Zoom to 75%; center one of the 
grid boxes in the window; and optimize the layout of the model's 

●     Distribute the model's Knowledge Units over several print pages.
●     Deactivate the Print Models on one Page option in the Print dialogue box. Select Page Grid and distribute 

the model's Knowledge Units in the grid boxes. The Knowledge Units will be printed according to their size 
and distribution on the grid.
The order of the print pages does not follow the model's hierarchical structure:
Number the Principal Knowledge Units of each of the Lower Models according to the hierarchical structure 
of the document's models or the desired print order of the models.
When the Main Model is part of the Print Range, it is always printed first.
The text of one or more objects is cut when printed:
Consider one or more of the following solutions.

●     Change the shape or increase the size of the objects to include the entire text.
●     Decrease the font size until all the text's characters are visible.

Check the results of your changes in the Print Preview window.
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Appendix 1: List of Keyboard Shortcuts 

In Alphabetical Order of the Commands 

  

COMMAND SHORTCUT MENU MODE 
Go to Lower Model Enter View graphic 
Go to Upper Model Backspace View graphic 

Send to Back Ctrl + - (on keypad) Layout graphic 
Send to Front Ctrl + + (on keypad) Layout graphic 

Undo Ctrl + Z Edit text and graphic 
Paste Ctrl + V Edit text and graphic 
Copy Ctrl + C Edit text and graphic 
Cut Ctrl + X Edit text and graphic 

Ungroup Ctrl + U Layout graphic 
Send Backward - (on keypad) Layout graphic 
Send Forward + (on keypad) Layout graphic 

Delete Del Edit text and graphic 
Save Ctrl + S File text and graphic 

Group Ctrl + G Layout graphic 
Print Ctrl + P File text and graphic 

New Graphic Document Ctrl + N File text and graphic 
Open Ctrl + O File text and graphic 

Open Lower Model Ctrl + Enter View graphic 
Open Upper Model Ctrl + Backspace View graphic 
Object Properties Alt + Enter Edit text and graphic 

Next Reference Alt + R View graphic 
Redo Ctrl + R Edit text and graphic 

Select All Ctrl + A Edit text and graphic 
Fit Model in Window Alt + A View graphic 

By Type of Shortcut 

  

SHORTCUT COMMAND MENU MODE 
- (on keypad) Send Backward Layout graphic 
+ (on keypad) Send Forward Layout graphic 

Enter Go to Lower Model View graphic 
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Del Delete Edit text and graphic 
Backspace Go to Upper Model View graphic 
Alt + Enter Object Properties Edit text and graphic 

Alt + R Next Reference View graphic 
Alt + A Fit Model in Window View graphic 
Alt + N Insert Neighbors Edit graphic 

Ctrl + - (on keypad) Send to Back Layout graphic 
Ctrl + + (on keypad) Send to Front Layout graphic 

Ctrl + A Select All Edit text and graphic 
Ctrl + Backspace Open Upper Model View graphic 

Ctrl + C Copy Edit text and graphic 
Ctrl + Enter Open Lower Model View graphic 

Ctrl + G Group Layout graphic 
Ctrl + N New Graphic Document File text and graphic 
Ctrl + O Open File text and graphic 
Ctrl + P Print File text and graphic 
Ctrl + R Redo Edit text and graphic 
Ctrl + S Save File text and graphic 
Ctrl + U Ungroup Layout graphic 
Ctrl + V Paste Edit text and graphic 
Ctrl + X Cut Edit text and graphic 
Ctrl + Z Undo Edit text and graphic 
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